Apple® IIe Card
Owner's Guide
for the Macintosh® LC
Limited Warranty on Media and Replacement

If you discover physical defects in the manuals distributed with an Apple product or in the media on which a software product is distributed, Apple will replace the media or manuals at no charge to you, provided you return the item to be replaced with proof of purchase to Apple or an authorized Apple dealer during the 90-day period after you purchased the software. In addition, Apple will replace damaged software media and manuals for as long as the software product is included in Apple's Media Exchange Program. While not an upgrade or update method, this program offers additional protection for two years or more from the date of your original purchase. See your authorized Apple dealer for program coverage and details. In some countries the replacement period may be different; check with your authorized Apple dealer.

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUALS, INCLUDING IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

Even though Apple has tested the software and reviewed the documentation, APPLE MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESSED OR IMPLIED, WITH RESPECT TO SOFTWARE, ITS QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS SOFTWARE IS SOLD "AS IS," AND YOU, THE PURCHASER, ARE ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE.

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, even if advised of the possibility of such damages. In particular, Apple shall have no liability for any programs or data stored in or used with Apple products, including the costs of recovering such programs or data.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESSED OR IMPLIED. No Apple dealer, agent, or employee is authorized to make any modification, extension, or addition to this warranty.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential damages, so the above limitation or exclusion may not apply to you. This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

Warning

This equipment has been certified to comply with the limits for a Class B digital device, in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to radio or television reception is suspected.

DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus set out in the radio interference regulations of the Canadian Department of Communications.

Observation des normes—Classe B Le présent appareil numérique n'émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la Classe B prescrites dans les règlements sur le brouillage radioélectrique édictés par le Ministre des Communications du Canada.
This manual and the software described in it are copyrighted, with all rights reserved. Under the copyright laws, this manual or the software may not be copied, in whole or part, without written consent of Apple, except in the normal use of the software or to make a backup copy of the software. The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the original. This exception does not allow copies to be made for others, whether or not sold, but all of the material purchased (with all backup copies) may be sold, given, or loaned to another person. Under the law, copying includes translating into another language or format.

You may use the software on any computer owned by you, but extra copies cannot be made for this purpose.

The Apple logo is a registered trademark of Apple Computer, Inc. Use of the "keyboard" Apple logo (Option-Shift-K) for commercial purposes without the prior written consent of Apple may constitute trademark infringement and unfair competition in violation of federal and state laws.

Apple Desktop Bus, Finder, and UniDisk are trademarks of Apple Computer, Inc.
Adobe, Adobe Illustrator, and PostScript are registered trademarks, and Adobe Garamond is a trademark, of Adobe Systems Incorporated.
Dolev PS is a trademark of Scitex Corporation Ltd.
Exposure is a registered trademark of Preferred Publishers, Inc.

ITC Zapf Dingbats is a registered trademark of International Typeface Corporation.
NuBus is a trademark of Texas Instruments.
QMS is a registered trademark and ColorScript is a trademark of QMS, Inc.
QuarkXPress is a registered trademark of Quark, Inc.
SuperPaint is produced by Silicon Beach Software.

Simultaneously published in the United States and Canada.

Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a recommendation. Apple assumes no responsibility with regard to the performance or use of these products.
Reserving hard disk space for Apple IIe files 4
Backing up your hard disk 5
Partitioning your hard disk 6
Restoring the contents of your hard disk 10
Rebuilding your system 11
What to do next 11
Connecting Apple IIe disk drives 12
Connecting the Apple 5.25 Drive 12
Connecting the UniDisk 3.5 Drive 15
Connecting more than one disk drive 17
Connecting other devices 20
Connecting your old Apple IIe hard disk 23
What’s next? 24

Chapter 2 Preparing the Software 25
Checking for late-breaking news 26
Preparing the startup disk for your Apple IIe Card 26
Deciding whether to use the hard disk as a IIe Card startup disk 27
Checking your version of system software 27
Installing the software on your hard disk 29
If you do not have (or do not wish to use) a hard disk 33
Making a copy of the floppy startup disk 34
Setting up the printer software 34
What’s next 36

Chapter 3 Learning to Use the Apple IIe Card 37
Important details for floppy disk startup people 38
Starting up from the IIe Startup Disk 38
Why you need to start up from the IIe Startup Disk 39
Switching between the Macintosh and Apple IIe environments 40
Switching to the Apple IIe environment 40
Switching back to the Macintosh environment 42
Special note for floppy disk startup people 43
Summary 43
Running an Apple IIe program  43
  Method 1: Double-clicking a Macintosh icon  43
    Can you do the double-click exercise?  43
    The double-click exercise  44
  Method 2: Restarting the Apple IIe Card  46
Using the Option Panel  48
  Opening and closing the Option Panel  48
  Exploring the Option Panel  50
  Practicing moving the cards in the Option Panel  53
Managing Apple IIe files  56
  Naming files on Apple IIe disks  58
  Using Macintosh programs with Apple IIe files  58

Chapter 4  Setting Up Cards and Slots  59
  Deciding how to arrange the cards in the Option Panel  60
    Basing the plan on your original Apple IIe  61
    Basing the plan on a typical Apple IIe  65
    File servers  66
    Modems and other serial devices except for printers  66
  Arranging the cards in the Option Panel  67
  Setting the options for your cards  69

Chapter 5  Reference  71
  Starting up the IIe Startup program  72
    Going directly to the Apple IIe Option Panel  74
    Double-clicking the IIe Prefs file  75
  Using more than one preferences file  75
  Starting up an Apple IIe program  76
    The Macintosh way  77
    The Apple IIe way  78
  Printing from Apple IIe programs  79
    Choosing a printer  79
  Using Apple IIe files with Macintosh programs  81
    Copying Apple IIe pictures  82
Using network file servers 83
  Starting up from the file server 83
  Using files from the file server 84
Personalizing your Apple IIe work environment 85
  Changing the processing speed setting 85
  Choosing a startup beep sound 87
  Setting the keys’ repeat rate 89
  Setting the delay before the keys repeat 90
  Changing the Type Ahead setting 92
  Changing the Display setting 93
  Changing the character set 95
  Changing or adding an Option Panel key 96
  Changing the mouse tracking rate 97
Configuring cards and slots 99
  Changing the Memory Expansion Card size 99
  Setting the Serial Cards 102
    Using modems at speeds higher than 1200 baud 105
Making changes to the Printer Card 105
  Extending printer timeout 106
  Choosing a printer 107
  Changing the slot settings 107
  Changing the startup device 109
    Saving time by making 5.25 Drives inactive 111
  Changing the SmartPort settings 112
Ejecting disks 114
Navigating in the Apple IIe environment 116
  Opening the Option Panel 116
    A shortcut for opening the Option Panel from the Macintosh environment 116
Limiting access to the Option Panel 116
  Locking the preferences file 116
    Purchasing and installing an optional jumper cable 117
    Hiding the preferences file 117
Returning to your work 118
Restarting the Apple IIe Card 120
Quitting the Apple IIe environment 122
Appendix E  Installing Printer Software for the *Ile Startup Disk*  151
   Is your printer's software already installed?  152
   Printers connected to original Apple Ile computers  152
   Installing the software for your printer  153

Appendix F  System 7 and the Apple Ile Card  155

   Glossary  157

   Index  163

   Quick Reference card
Radio and television interference

The equipment described in this manual generates and uses radio-frequency energy. If it is not installed and used properly—that is, in strict accordance with Apple's instructions—it may cause interference with radio and television reception.

This equipment has been tested and complies with the limits for a Class B digital device in accordance with the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection against such interference in a residential installation. However, there is no guarantee that the interference will not occur in a particular installation.

You can determine whether your computer is causing interference by turning it off. If the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct the interference by using one or more of the following measures:

- Turn the television or radio antenna until the interference stops.
- Move the computer to one side or the other of the television or radio.
- Move the computer farther away from the television or radio.
- Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, make certain the computer and the television or radio are on circuits controlled by different circuit breakers or fuses.)
- Install a rooftop television antenna with a coaxial cable lead-in between the antenna and the television.

If necessary, consult your authorized Apple dealer or an experienced radio/television technician for additional suggestions. You may find helpful the following booklet, prepared by the Federal Communications Commission: How to Identify and Resolve Radio-TV Interference Problems (stock number 004-000-00345-4). This booklet is available from the U.S. Government Printing Office, Washington, DC 20402.

⚠️ Important: Changes or modifications to this product not authorized by Apple Computer, Inc., could void the FCC certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of shielded cables and connectors between system components. It is important that you use shielded cables and connectors to reduce the possibility of causing interference to radios, television sets, and other electronic devices. For Apple peripheral devices, you can obtain the proper shielded cables from your authorized Apple dealer. For non-Apple peripheral devices, contact the manufacturer or dealer for assistance. ⚠️
Before You Start

Now you have the best of both worlds. With an Apple® IIe Card installed in your Macintosh® LC computer, you can take advantage of the newest Macintosh technology and still run the world's largest collection of personal computer software—more than 10,000 Apple IIe programs. This guide tells you how.
About the Apple IIe Card

The Apple IIe Card is an accessory card that lets you run Apple IIe programs on a Macintosh LC computer. Once you've set a few options in the card's Option Panel, turning the Macintosh into an Apple IIe is as simple as double-clicking an icon on the Macintosh desktop.

While your Macintosh LC is in the Apple IIe environment, it performs just like an Apple IIe computer. You start up Apple IIe programs, work with Apple IIe files, use Apple II system utilities—just as you do on an Apple IIe. And what you see on the Macintosh monitor is exactly what you'd see on an Apple IIe monitor.

And you can return to the Macintosh desktop by clicking a button.
About this guide

This guide contains all the information you need to use the Apple IIe Card with your Macintosh LC. Here’s what you’ll find in this guide:

- Chapter 1, “Preparing the Equipment,” tells you how to connect Apple IIe disk drives and other devices to your Macintosh LC computer. It also discusses how to prepare your hard disk so it can store Apple IIe files.

- Chapter 2, “Preparing the Software,” tells you how to install the Apple IIe Card software.

- Chapter 3, “Learning to Use the Apple IIe Card,” contains a brief tutorial that teaches you step by step how to run Apple IIe programs on the Macintosh LC.

- Chapter 4, “Setting Up Cards and Slots,” describes how to use the special Apple IIe Card software to install and arrange the Apple IIe cards.

- Chapter 5, “Reference,” provides instructions for all the features of the Apple IIe Card and its software program, IIe Startup.

- Appendix A, “Troubleshooting,” provides important tips to help you if you run into problems.

- Appendix B, “Using a Hard Disk,” explains how to store and use Apple IIe programs and files on your hard disk.

- Appendix C, “Creating Custom Partitions,” gives technical details on how to create a ProDOS® partition on your hard disk if you need the partition to be larger or smaller than the standard 10 megabytes (MB).

- Appendix D, “Parts of the Apple IIe Card Software,” explains what each of the Apple IIe Card files does.

- Appendix E, “Installing Printer Software for the IIe Startup Disk,” describes what to do if you use the IIe Startup Disk but the printer software you require isn’t installed.
Appendix F, "System 7 and the Apple IIe Card," explains that Apple does not recommend using the Apple IIe Card with System 7 but offers advice for those who want to try it anyway. You'll also find a glossary and an index at the end of the guide. Inside the back cover, you'll also find a Tell Apple card. Be sure to fill out the card and send it in. We want to know what you think about Apple products and training materials.

Finally, the book has a removable Quick Reference card, which you can detach and use to remind yourself of the most important hard-to-remember details concerning the Apple IIe Card.

Before you begin

This guide makes the following assumptions about your computer system and about your level of experience with Apple products. Before you begin, make sure the following are true:

- **The Apple IIe Card is installed in your Macintosh LC.**
  
  If the card is not installed, don't try to install it yourself. Only qualified service technicians should install and remove the Apple IIe Card. If the Apple IIe Card is not already installed in your computer, contact your authorized Apple dealer.

- **Your Macintosh LC is set up.**
  
  If you haven't set up your Macintosh LC yet, go now to the setup instructions that came with your computer.

- **You know how to operate the Macintosh LC.**
  
  If you don't know basic Macintosh skills, see the instructional materials that came with the Macintosh LC computer.
- You are already familiar with running Apple IIe programs and utilities.

If you lack Apple IIe experience, and you don't have access to Apple IIe manuals, contact your authorized Apple dealer, who can suggest appropriate books and other instructional materials for you.

A note about system software

The Apple IIe Card software works only with version 6.0.8 of system software. If you have a different version of Macintosh system software installed on your hard disk, or if you don't use a hard disk at all, you can use the disk labeled IIe Startup Disk to run your Apple IIe programs.

Some visual cues

This book uses some special text elements to help guide you. Use them as visual cues as you read:

- *By the way:* Text set off in this manner presents sidelights or interesting pieces of information. *

- **Important:** Text set off in this manner presents important information. △

- **Warning:** Warnings like this alert you to situations in which you might damage your equipment or lose data if you don't follow the instructions carefully. ▲

Special terms appear in italics when they are introduced; these terms are defined in the glossary at the back of the guide.

You may be familiar with the ☞ (Open Apple) key and the ☞ (Solid Apple) key on Apple IIe keyboards. On the Macintosh keyboard, use the ≡ (Command) key in place of the ☞ key and the Option key in place of the ☞ key.
User groups

No matter what your level of computer experience, you can get lots of support by joining an Apple user group. Apple user groups are composed of people who work with Apple computers and who enjoy sharing what they know with others. Activities may include new product demonstrations, informal question-and-answer sessions, and regular classes on using popular software applications or learning to write your own programs. Many user groups have special beginners' nights.

Ask your authorized Apple dealer for the name of the user group nearest you, or call (800) 538-9696. For names of user groups outside the United States, or if you are interested in starting your own user group, contact

Berkeley Macintosh Users’ Group
1442-A Walnut Street, #62
Berkley, CA 94709
U.S.A.
(415) 549-BMUG (415-549-2684)

Boston Computer Society
One Center Plaza
Boston, MA 02108
U.S.A.
(617) 367-8080
Preparing the Equipment

The Apple® IIe Card should already be installed in your Macintosh® LC computer. You don't need to assemble or connect anything else to run Apple IIe programs on your Macintosh LC.

However, if you want to use a hard disk to store Apple IIe information or if you want to connect any Apple IIe disk drives or other devices, you'll need to follow the instructions in this chapter.

Otherwise, you can skip now to Chapter 2, “Preparing the Software.”

⚠️ **Warning:** Before connecting anything to your computer, make sure the power cord is plugged in and the power is turned off. The power cord acts as a ground for your computer, protecting you from electrical shock, even when the computer is turned off. ⚠️
Protecting the disks

Before you do anything else, you should lock the two disks that came with the Apple IIe Card: the IIe Installer Disk and the IIe Startup Disk. Locking disks prevents you from accidentally changing or erasing the files.

To lock a disk, slide the plastic tab on the back of the disk. When you can see through the hole, the disk is locked.

Using a hard disk to store Apple IIe files

This section helps you decide whether you should store your Apple IIe files on a hard disk or keep them on 3.5-inch and 5.25-inch floppy disks. If you decide to store Apple IIe files on your hard disk, this section also tells you how to prepare the hard disk so it can store both Macintosh and Apple IIe files.

If you don't have a hard disk, you can go immediately to the next main section, "Connecting Apple IIe Disk Drives."

Deciding where to store your Apple IIe files

If you have a hard disk, you need to decide whether you want to reserve part of it for Apple IIe files. The sooner you decide, the easier it will be to prepare the hard disk.
Why you might want to use the hard disk

The greatest advantage of storing Apple IIe information on a hard disk is ease of use: you can store all your ProDOS® files in one place, so you don’t have to remember where a particular file is. Also, using a hard disk allows you to store and retrieve information more quickly.

- *A note about system software:* The Macintosh uses special software to make Apple IIe files look and act just like other files on the Macintosh desktop. This special software, a startup document called ProDOS File System, requires version 6.0.8 of system software. If you don’t have version 6.0.8 of Macintosh system software, you can still store Apple IIe files on your hard disk, but the Apple IIe files won’t normally be visible except while you’re running Apple IIe programs.

Why you might *not* want to use the hard disk

The greatest disadvantage of using your hard disk to store Apple IIe information is that it reduces the amount of hard disk storage available for Macintosh files. Also, the process of creating space for your Apple IIe files is time-consuming, and requires you to erase your hard disk.

Some suggestions

If you’ll be using your Apple IIe files a lot, or if your Apple IIe files are too big to fit on floppy disks, set aside a portion of your hard disk for them. If a number of people are sharing the computer (in a school for example), you can store Apple IIe programs on the hard disk while people store their personal files on their own floppy disks.

If you plan to use your Apple IIe files only occasionally, keep them on floppy disks and save your hard disk exclusively for Macintosh files.
The advantage of making your decision right away

You can't store both Apple IIe files and Macintosh files on the same hard disk unless you reserve part of the hard disk for Apple IIe files. Unfortunately, the procedure that reserves the space requires you to erase all information stored on the hard disk.

If you decide to reserve space for Apple IIe files when you've just gotten your computer, you won't yet have any personal information on the hard disk, so erasing the hard disk won't be too disruptive. Later, if you have a lot of information stored, you'll have to take extra steps to copy your data before you erase the hard disk and then put the data back afterward.

What to do next

If you've decided to store Apple IIe files on your hard disk, continue with this section. Otherwise, skip ahead to the next main section, "Connecting Apple IIe Disk Drives."

Reserving hard disk space for Apple IIe files

This section is for people who have an Apple hard disk connected to their Macintosh LC and want to use a portion of it to store Apple IIe files. (The hard disk can be built into the Macintosh or connected by a cable.) The process of reserving part of the hard disk for Apple IIe files is called *partitioning* the hard disk.

Partitioning your hard disk erases everything already stored on it, so before partitioning you must make backup copies of any files on your hard disk. This section explains how to

- back up the contents of your hard disk
- create an Apple IIe partition on your hard disk
- restore the original contents of your hard disk
Backing up your hard disk

To back up your hard disk, follow the steps in this section. (If you normally use another method of backing up your files, such as copying them to another hard disk or to a tape cartridge, you can use that method instead.)

1. **Turn on your Macintosh LC computer.**
   
   If your computer is already on, quit any programs you might be running.

2. **Insert a blank 3.5-inch floppy disk into the built-in disk drive.**
   
   If you see a message asking if you want to initialize the disk, click Initialize. (If you’re using an 800K disk, click Double-Sided.)

3. **Copy your files and folders to the floppy disk.**
   
   Drag each icon from your hard disk to the floppy disk’s icon until you get a message that the floppy disk is full. Then eject the floppy disk and repeat the procedure until you’ve backed up all the files you want to save.

   Some folders may be too big to fit on floppy disks. If so, you can open the folder and drag its contents one icon at a time to the floppy disk icon.

   For more information about copying files and folders, see the books that came with your Macintosh.

4. **Label the disks so you can remember what’s on them.**
Partitioning your hard disk

This section explains how to partition your hard disk using a program called Apple HD SC Setup.

**How much space do you need?** The procedure described in this section sets aside 10 MB of space for Apple IIe files. If you need a different amount, turn now to Appendix C, “Creating Custom Partitions,” and read the section called “The Custom Partition.” When you finish, skip to the next section in this chapter, “Restoring the Contents of the Hard Disk.”

Follow these steps to partition the hard disk:

⚠ **Warning:** Partitioning erases all information stored on your hard disk. To preserve your information, see the previous section, “Backing Up Your Hard Disk.”

**Before you begin:** This procedure requires 10 MB of hard disk space. Be sure you can afford to give up that much space.

1. **Shut down your Macintosh.**
   
   Choose the Shut Down command from the Special menu. You do not have to turn off the power.

2. **Insert the IIe Installer Disk into the built-in disk drive.**

3. **Start up the Macintosh.**
   
   Click the Restart button if your Macintosh is already on; otherwise, turn on the power.

4. **If necessary, open the IIe Installer Disk by double-clicking its icon.**
   
   The disk’s window appears.
5. Double-click the Apple HD SC Setup icon.

The Setup program opens, as shown in the next step.

6. If you have more than one hard disk, click the Drive button to select the one that you want to partition.

7. Click the Partition button.

A screen appears with all your partitioning options, as shown in the next step.
8. Click "10MB ProDOS, Maximum Macintosh," then click OK.

A dialog box appears to confirm that you want to erase your hard disk.

9. Click OK in the dialog box.

The program takes a few moments to partition the disk drive and then asks you to name the new Apple Ile partition.

10. Type a name and then click OK.

The dialog box appears with a suggested name in it. As soon as you start typing, the suggested name is replaced by what you type.
You can give the new partition any legal ProDOS name, and you can use lowercase letters and spaces. ProDOS names may have any combination of 15 numbers and letters. (The program will tell you if you type an illegal name.)

11. Finally, click Quit.

You return to the regular desktop, and your new partition appears:

You now have two icons representing the same hard disk. The new icon, with the symbol for the Apple IIe on it, represents the space reserved for your Apple IIe files. The original icon represents the rest of the hard disk, which is reserved for Macintosh files.
12. Drag the BASIC.SYSTEM icon to the new Apple IIe partition.
   The file is copied to the new partition.

13. Drag the PRODOS icon to the new Apple IIe partition.
   The file is copied to the new partition.

Restoring the contents of your hard disk

If you backed up the contents of your hard disk, you should now copy the files back to the Macintosh portion of your hard disk. Follow these steps to restore your hard disk:

1. Eject the IIe Installer Disk by dragging its icon to the Trash.
   Its icon becomes dimmed.

2. Insert one of your backup disks into the disk drive.
   The disk’s icon appears on the desktop.

3. Copy all the files and folders back to your hard disk.
   Drag each icon from your floppy disk back to the hard disk’s icon.
   If you broke up the contents of a folder across more than one disk when you backed up, don’t forget to put all that folder’s files back in the folder again.

4. Eject the first disk and repeat steps 2 and 3 for each backup disk.

5. Choose Restart from the Special menu.
   The Macintosh automatically ejects any disk in its disk drive and restarts.
Why did the new Apple IIe ProDOS partition disappear?

Your Macintosh can't display ProDOS files until you've installed the Apple IIe Card software. In the next chapter, you will install the software for the Apple IIe Card. Meanwhile, even though you can't see it, the ProDOS partition is still there.

You can now use your Apple IIe partition to store any Apple IIe files and programs. For details, see Appendix B, "Using a Hard Disk."

Rebuilding your system

Sometimes copying a System Folder onto floppy disks and then back to your hard disk, as you did in the previous sections, can cause problems such as system crashes. If so, or if you want to prevent such problems, you may want to rebuild your system.

To rebuild your system, use the Installer program that came with your Macintosh (or with your most recent version of system software) to reinstall system software. See the manuals that came with your Macintosh (or with your most recent version of system software) for instructions. Check the index and table of contents for entries like "installing system software" or "reinstalling system software."

What to do next

If you have any Apple IIe devices to connect to your Macintosh LC, such as disk drives or joysticks, continue with this chapter. Otherwise, you can go to Chapter 2, "Preparing the Software."
You need to read this section only if you have an Apple IIe floppy disk drive to connect to your Macintosh LC. If you have nothing else to connect to the Macintosh, you can go immediately to Chapter 2, “Preparing the Software.” If you have devices other than floppy disk drives to connect, you can skip ahead to the appropriate section in this chapter.

You can use two types of Apple IIe floppy disk drives with the Macintosh LC—the gray Apple 5.25 Drive and the white UniDisk™ 3.5 Drive. Earlier Apple II disk drives—the Disk II®, UniDisk 5.25, and DuoDisk® drives, for instance—cannot be used with the Macintosh LC.

⚠️ **Warning:** Only two types of Apple II disk drives—the gray Apple 5.25 Drive and the white UniDisk 3.5 Drive—are compatible with the Macintosh LC. Do not try to use any other types of Apple II disk drive with the Macintosh LC. Doing so may damage the disk drive or the computer, and may destroy the contents of your Apple II disks. ⚠️

### Connecting the Apple 5.25 Drive

Follow these steps to connect an Apple 5.25 Drive to the Macintosh LC:

⚠️ **Warning:** Before connecting anything to your computer, make sure the power cord is plugged in and the power is turned off. The power cord acts as a ground for your computer, protecting you from electrical shock, even when the computer is turned off. ⚠️
1. Plug the Y-shaped cable into the Apple IIe port on the computer's back panel, as shown in the figure.

The Y-shaped cable comes with the other Apple IIe Card materials.

Be sure the connectors line up correctly. Tighten the connector screws to ensure a proper fit.
2. Connect the Apple 5.25 Drive cable to the larger of the two remaining connectors on the Y-shaped cable, as shown in the figure.

Again, be sure the D-shaped connectors line up correctly, and tighten the connector screws to ensure a proper fit.

⚠️ Warning: If you want to swap drives or devices connected to the Y-shaped cable, be sure to turn off the computer first. If you change devices while the computer is on, you may damage the device or the computer, or both. ⚠️
Connecting the UniDisk 3.5 Drive

Follow these steps to connect a UniDisk 3.5 Drive to the Macintosh LC:

**Warning:** Before connecting anything to your computer, make sure the power cord is plugged in and the power is turned off. The power cord acts as a ground for your computer, protecting you from electrical shock, even when the computer is turned off.

1. Plug the Y-shaped cable into the Apple IIe port on the computer’s back panel, as shown in the figure.

   The Y-shaped cable comes with the other Apple IIe Card materials.

   Be sure the connectors line up correctly. Tighten the connector screws to ensure a proper fit.
2. Connect the UniDisk 3.5 Drive cable to the larger of the two remaining connectors on the Y-shaped cable, as shown in the figure.

Again, be sure the connectors line up correctly, and tighten the connector screws to ensure a proper fit.

\[\text{Diagram of connector setup}\]

\[\text{Warning: If you want to swap drives or devices connected to the Y-shaped cable, be sure to turn off the computer first. If you change devices while the computer is on, you may damage the device or the computer, or both.}\]
You can connect more than one Apple IIe disk drive to the Macintosh LC by daisy-chaining them. However, the drives must be connected in the correct order for them to work properly:

- If you have two Apple 5.25 Drives, connect the first drive to the Y-shaped cable. Then connect the second drive to the first drive by plugging the connector from the second drive into the port on the back of the first drive.
If you have a UniDisk 3.5 Drive and one Apple 5.25 Drive, first connect the UniDisk 3.5 Drive to the Y-shaped cable. Then connect the Apple 5.25 Drive to the UniDisk 3.5 Drive by plugging the connector from the Apple 5.25 Drive into the port on the back of the UniDisk 3.5 Drive.
If you have a UniDisk 3.5 Drive and two Apple 5.25 Drives, first connect the UniDisk 3.5 Drive to the Y-shaped cable. Then connect the first Apple 5.25 Drive to the UniDisk 3.5 Drive by plugging the connector from the 5.25 Drive into the port on the back of the UniDisk 3.5 Drive. Then connect the second 5.25 Drive to the first 5.25 Drive by plugging the connector from the second 5.25 Drive into the port on the back of the first 5.25 Drive.

⚠️ Important: If you plan to use both a UniDisk 3.5 Drive and one or more Apple 5.25 Drives with the Macintosh LC, you must position the UniDisk drive first in the daisy chain. The disk drives will not work correctly if a 5.25 Drive is positioned first in the chain. ⚠️

⚠️ Warning: If you want to swap drives or devices connected to the Y-shaped cable, be sure to turn off the computer first. If you change devices while the computer is on, you may damage the device or the computer, or both. ⚠️
Connecting other devices

You may have an Apple IIe device—such as a joystick or hand controls—that you’d like to use with the Macintosh LC. (Note: The only joystick supported by the Apple IIe Card is the one with 9 pins in the connector.) Follow these instructions:

⚠️ Warning: Before connecting anything to your computer, make sure the power cord is plugged in and the power is turned off. The power cord acts as a ground for your computer, protecting you from electrical shock, even when the computer is turned off. ⚠️
1. Plug the Y-shaped cable into the Apple IIe port on the computer's back panel, as shown in the figure.

The Y-shaped cable comes with the other Apple IIe Card materials.

Be sure the connectors line up correctly. Tighten the connector screws to ensure a proper fit.
2. Connect the device's cable connector to the smaller of the two connectors on the Y-shaped cable, as shown in the figure. Again, be sure the connectors line up correctly, and tighten the connector screws to ensure a proper fit.

You can connect only one Apple IIe device at a time to the smaller connector on the Y-shaped cable. If you want to use more than one device, you'll need to swap the devices.

⚠️ Warning: If you want to swap drives or devices connected to the Y-shaped cable, be sure to turn off the computer first. If you change devices while the computer is on, you may damage the device or the computer, or both. ⚠️
Connecting your old Apple IIe hard disk

If you have an Apple SCSI hard disk connected to your original Apple IIe computer, you can connect it to your Macintosh LC and use it just as you would any other hard disk.

⚠️ Important: Only SCSI hard disks can be connected to the Macintosh LC. If the hard disk's cable fits into the large SCSI port on the back of the Macintosh, you can connect it. ⚠️

To prepare the hard disk so your Macintosh can store files on it, you must erase all the files on it. Follow these steps to make copies of the files, erase and initialize the hard disk, and connect it to your Macintosh:

**Before you begin:** Make sure the hard disk is still connected to your Apple IIe.

1. **Turn on the hard disk and your Apple IIe.**
2. **Copy all the files on the hard disk to some other place.**
   
   You can copy the files to a series of floppy disks or to a file server.
3. **Turn off your Apple IIe and the hard disk.**
4. **Make sure your Macintosh LC is turned off.**
5. **Connect the hard disk to your Macintosh LC.**

If you have another SCSI device connected to your Macintosh LC, see the manuals that came with your hard disk or your Macintosh for detailed information on connecting several SCSI devices in a chain.
6. Plug in the hard disk, then turn it on.

7. Initialize the hard disk using Apple HD SC Setup.

   You can find complete instructions for preparing the hard disk using Apple HD SC Setup in the manuals that came with your Macintosh or with the hard disk.

8. If you like, you can copy the files you backed up in step 2 onto your hard disk, provided you created an Apple IIe partition, as described earlier in this chapter.

What's next? You’ve successfully connected your Apple IIe disk drives and other devices to the Macintosh LC. Next, you must install the software that allows you to use the Apple IIe Card so you can start your work.
All your equipment should now be ready. Once you install the software, as described in this chapter, you’ll be ready to start using Apple IIe software on your Macintosh.
Checking for late-breaking news

You can see if there were any last-minute changes to the instructions for the Apple IIe Card by checking the Read Me file, as described in this section.

**Before you begin:** If your computer is off, turn it on. If your computer is on, quit any programs you might be running.

1. Insert the *IIe Installer Disk* into the disk drive.
   
   The disk's icon appears.

2. If necessary, open the *IIe Installer Disk* by double-clicking its icon.
   
   The disk's window appears.

3. Open the Read Me file by double-clicking its icon.

   ![Read Me icon](image)
   
   Double-click to read late-breaking news.

4. Read the file.
   
   If necessary, use the scroll bar to see the whole document.

5. Choose Quit from the File menu.
   
   The file closes.
Preparing the startup disk for your Apple IIe Card

To use your Apple IIe Card, you must have certain files on your Macintosh startup disk. (A startup disk is any disk—either a hard disk or a 3.5-inch floppy disk—that contains a System Folder.)

This section explains how to install the new Apple IIe Card software on your startup disk and how to create a new startup disk, if necessary.

If your Macintosh LC has a hard disk, either built-in or attached to it, you must decide whether to use the hard disk as the startup disk for your Apple IIe Card.

Deciding whether to use the hard disk as a IIe Card startup disk

If your Macintosh has a hard disk, it's a good idea to use it as the startup disk. Otherwise, you'd have to restart the Macintosh every time you want to switch between the Macintosh environment and the Apple IIe environment.

However, you can only use the hard disk as your startup disk if you have version 6.0.8 of system software. (If you're not sure what version of system software you have, see the next section, “Checking Your Version of System Software.”) If you have a different version, you'll have to use a floppy disk as your Macintosh startup disk when you want to run Apple IIe programs. Go to the section “If You Do Not Have (or Do Not Wish to Use) a Hard Disk” for instructions.

Checking your version of system software

Follow these steps to see what version of system software you have:

Before you begin: Turn on your Macintosh LC.

1. Quit any programs that are running.
2. Choose the Restart command from the Special menu.

The computer restarts.
3. Choose the first command from the Apple menu.

Depending on which version of system software you have, the first command will be either About the Finder or About This Macintosh.

The About box opens.

4. Note the version number.

If the version number is in the upper-right corner of the About box, you have version 7 of system software.

5. Choose the Close or Close Window command from the File menu.

The About box closes.
What you do next depends on which version of system software you have:

- **Version 6.0.8.** If you have version 6.0.8, you can install the Apple IIe Card software on your hard disk, as described in the next section, “Installing the Software on Your Hard Disk.”

- **Other versions.** If you have any other version, you need to use a floppy disk as your Macintosh startup disk when you want to run Apple IIe programs. Go now to the section “If You Do Not Have (Or Do Not Wish To Use) a Hard Disk.”

Alternatively, if you wish, you can get version 6.0.8 of system software from your Apple authorized dealer and install it on your hard disk.

- **Note for System 7 users:** Though Apple does not recommend it, some people may want to see if they can use the Apple IIe Card with version 7 of system software. If you're one of those people, see Appendix F, “System 7 and the Apple IIe Card.”

### Installing the software on your hard disk

This section explains how to use a program called the Installer to copy the necessary files to your hard disk.

⚠️ **Important:** You should install this software on your hard disk only if your hard disk has version 6.0.8 of system software, as explained in the previous section, “Deciding Whether to Use the Hard Disk as a IIe Card Startup Disk.” ⚠️
Once you finish this section, it’s important to remember that you installed the software on your hard disk. Many tasks in this book will have special notes for *hard disk startup people*. When you see one of these notes, remember that it applies to you.

- *Note for people who partitioned their hard disk in Chapter 1:*
  This installation procedure installs the software on the Macintosh partition of your hard disk.

**Before you begin:** If your computer is off, turn it on. If your computer is on, quit any programs you are running.

1. **Insert the IIE Installer Disk** into the built-in disk drive and double-click its icon.

   The disk’s window opens.

2. **Open the Installer program** by double-clicking its icon.

   ![Installer Icon]  
   Double-click to open the Installer program.

   After a moment, information about the Installer appears on your screen.

3. **Once you’ve read the information, click OK.**

   The Easy Install screen appears, as shown in the next step.
4. If you have more than one hard disk, click the Switch Disk button to select the hard disk where you want the software installed.

![Switch Disk Diagram]

Click this button ... until the name of the hard disk you want appears here.

5. Click Install.

![Install Button]

The Installer copies the files to your hard disk while displaying its progress. After it's finished, it displays a dialog box, as shown in the next step.
6. Click Quit.

![Installation on "HD" was successful. If you are finished, click Quit to leave the Installer. If you want to do additional installations, click Continue.](image)

Continue Quit

7. Notice the three new files installed on your hard disk.

Open your hard disk by double-clicking its icon and notice these three new icons:

- BASIC.SYSTEM
- lle Startup
- PRODOS

There's also a fourth new file in your System Folder. It's called ProDOS File System.

8. Choose the Restart command from the Special menu.

The computer ejects the lle Installer Disk and restarts. If you created a ProDOS partition in Chapter 1, you see its icon on the desktop after the computer restarts.
9. Find the Quick Reference card in the back of this book and mark the blank that says you are a hard disk startup person.

It's vital for you to remember where you installed your software because many tasks later in this book have different instructions for hard disk startup people and for floppy disk startup people.

10. Skip ahead to the “What’s Next?” section at the end of this chapter.

If you do not have (or do not wish to use) a hard disk

If you can't use a hard disk as your startup disk to run the Apple IIe Card software—either because you don't have one or because your hard disk has an incompatible version of system software—this section tells you how to use a floppy disk instead.

⚠ Important: If you installed the software on your hard disk in the previous section, you should skip this section and move ahead to “What’s Next?” at the end of this chapter. ⚠

Included with your Apple IIe Card is a disk called IIe Startup Disk, which has the necessary Apple IIe Card software and the correct version of Macintosh system software already installed. To use it, you need to make a copy of the disk and make sure you have the correct software for your printer, as described in the next two sections.

Once you finish this section, it's important to remember that you have your Apple IIe Card software on a floppy disk. Many tasks in this book will have special notes for floppy disk startup people. When you see one of these notes, remember that it applies to you.
Making a copy of the floppy startup disk

To make sure you always have a safe copy of the *IIe Startup Disk*, don't ever use the original. Instead, make a copy and set the original aside for safekeeping.

You can find instructions for copying disks in the books that came with your Macintosh.

When you are finished, put the original away and keep the copy ready for use. Don't lock the copy.

Setting up the printer software

If you don't have a printer, skip this section. If you do have a printer, follow these steps to set up your printer software:

1. **Shut down your Macintosh.**
   
   If your Macintosh is on, quit any programs you might be running, then choose Shut Down from the Special menu.

2. **Insert your copy of the *IIe Startup Disk* into the built-in floppy disk drive.**

3. **Turn on the computer and the monitor.**
   
   If you see a Restart button on the screen, click it.
   
   The computer starts up.

4. **Select the Chooser from the Apple menu.**
   
   After a moment, the Chooser window appears.

5. **Click the icon that represents the kind of printer you want to use.**
If your Chooser window looks different, you may have to use the scroll bar to see all these choices.

ImageWriter II, connected over a network
Any LaserWriter or LaserWriter II, plus the Personal LaserWriter NT
ImageWriter LQ, connected directly

- Your printer isn't there? If the kind of printer you want to use isn't in the Chooser, you need to install the printer software. Turn now to Appendix E, "Installing Printer Software for the 11e Startup Disk."

6. If the printer is connected over a network, you need to click the name of your printer and perhaps also the zone it's in.

See the reference book that came with your Macintosh for more information on using the Chooser.

7. Choose Close from the File menu.

8. Find the Quick Reference card in the back of the book and mark the blank that says you are a floppy disk startup person.

It's vital for you to remember where you installed your software because many tasks later in this book will have different instructions for floppy disk startup people and for hard disk startup people.
What’s next  You have one more step before you’re finished installing the Apple IIc hardware and software. You must use a software program to arrange the Apple IIe accessory cards in your Macintosh LC. But first, you must become better acquainted with the Apple IIe environment on the Macintosh.

The next chapter, “Learning to Use the Apple IIe Card,” introduces you to the Apple IIe environment. Chapter 4, “Setting Up Cards and Slots,” explains how to use the Apple IIe Card software to arrange the cards in your Macintosh LC.
Learning to Use the Apple IIe Card

This chapter teaches you step by step how to run Apple IIe programs on your Macintosh LC. You'll learn how to:

- switch between the Macintosh environment and the Apple IIe environment
- run Apple IIe programs on your Macintosh
- control your Apple IIe environment using the Option Panel
- organize your Apple IIe and Macintosh files

⚠️ Important: Before you can do the exercises in this chapter, you must set up your Apple IIe equipment and install the accompanying software as described in Chapters 1 and 2. ⚠️
Important details for floppy disk startup people

In the last chapter, you installed special software for your Apple Ile Card, and you are now either a hard disk startup person or a floppy disk startup person. (You recorded which you were on the Quick Reference card. See the previous chapter if you can't remember which you are.) If you're a hard disk person, this section does not pertain to you. Skip ahead to “Switching Between the Macintosh and Apple Ile Environments.”

△ Important: If you are a hard disk startup person, stop reading this section now and skip to “Switching Between the Macintosh and Apple Ile Environments.”

If you're a floppy disk startup person, you need to know a crucial technique—starting up from the Ile Startup Disk—because it's the only way to run Apple Ile programs and manipulate Apple Ile files. The technique is described in the next section, “Starting Up From the Ile Startup Disk.”

Starting up from the Ile Startup Disk

To start up from the Ile Startup Disk, you must turn on your computer with the disk in the disk drive, as shown in these steps.

△ Important: If you are a hard disk startup person, stop reading this section now and skip to “Switching Between the Macintosh and Apple Ile Environments.”

1. If your Macintosh LC is on, shut it down.
   Quit any programs you might be running and choose Shut Down from the Special menu. You don't need to turn off the power.
2. While the computer is shut down, insert your copy of the *Ile Startup Disk* into the built-in disk drive.

   Make sure the disk is not locked.

3. Turn on the Macintosh LC.

   If you see a Restart button on your screen, click it.

You've just started up from the *Ile Startup Disk*, so you can run Apple IIe programs and manipulate Apple IIe files until you shut down or restart the Macintosh LC.

Why you need to start up from the *Ile Startup Disk*

This section explains why you need to start up from the *Ile Startup Disk* to work with Apple IIe files or programs. (If you're not interested, you can skip this section.)

Normally, Macintosh computers can't recognize Apple IIe disks. (In fact, if you insert an Apple IIe disk into a normal Macintosh, the Macintosh asks if you want to erase it.) To be able to recognize Apple IIe disks, your Macintosh needs a special startup document, called *ProDOS File System*, in the System Folder it uses to start up.

If you're a floppy disk startup person, either you don't have a hard disk or the System Folder on your hard disk doesn't contain this special file (perhaps because your hard disk contains a version of system software that doesn't work with the Apple IIe Card). However, the System Folder on the *Ile Startup Disk* does contain it.

When you restart the computer with the *Ile Startup Disk* in the disk drive, the ProDOS File System document is loaded, enabling the Macintosh to recognize Apple IIe files.
Switching between the Macintosh and Apple IIe environments

Having a Macintosh LC with an Apple IIe Card is like having two computers in one. You can easily have the computer switch between acting like a Macintosh and acting like an Apple IIe. The exercises in this section explain how.

Switching to the Apple IIe environment

You enter the Apple IIe environment simply by double-clicking an icon, as shown in this exercise.

Before you begin: Your Macintosh should be turned on and you should quit any programs you might be running. Close any windows on your desktop.

1. If you’re a floppy disk startup person, make sure you’ve started up from the IIe Startup Disk.
   See the instructions in “Starting Up From the IIe Startup Disk,” at the beginning of this chapter.

2. Open your startup disk by double-clicking its icon.
3. Double-click the IIe Startup icon.

In a few moments, you see an Apple IIe Screen with a BASIC prompt and a blinking cursor.

Congratulations! You’ve turned your Macintosh LC into an Apple IIe. Once you double-click the IIe Startup program, your Macintosh LC is in the Apple IIe environment: Now the computer behaves as if it were an Apple IIe.

You’ll learn more about the Apple IIe environment later in this chapter, but first you’ll learn how to return to the Macintosh environment.
Switching back to the Macintosh environment

Follow these steps to return to the Macintosh environment:

1. **Press Control-\+Esc** to open the Option Panel.

   Press all three keys at once. If you have the standard keyboard, all three keys are on the same row as the Space bar.

   ![ctrl + apple + esc](image)

   The Option Panel opens, as shown in the next step.

2. **Click the Quit Ile button.**

   ![Option Panel](image)

   You return to the Macintosh environment.

Chapter 3: Learning to Use the Apple Ile Card
Special note for floppy disk startup people

If you are a floppy disk startup person, and if you are finished using Apple IIe programs and files for a while, you may want to return to using your usual startup disk. To do so, choose Restart from the Special menu.

Summary

To enter the Apple IIe environment, just start up from the correct disk and double-click the IIe Startup icon. To return to the Macintosh environment, open the Option Panel by pressing Control-38-Esc and then click the Quit IIe button.

Running an Apple IIe Program

There are two ways to start running Apple IIe programs. One way works if you’re in the Macintosh environment; the other way works if you’re in the Apple IIe environment.

This section has two exercises—one to illustrate each method. Depending on your setup, you may be able to complete only one of them.

Method 1: Double-clicking a Macintosh icon

When you are in the Macintosh environment, you can launch Apple IIe programs the same way you launch Macintosh programs—by double-clicking an icon.

Can you do the double-click exercise?

To do this exercise, you must have an Apple IIe program on a 3.5-inch ProDOS disk. The program must not be copy-protected.

You must also have one empty disk drive. Consequently, you cannot do this exercise if you’re a floppy disk startup person who has only one floppy disk drive.

If you can’t do this exercise, skip ahead to “Method 2: Restarting the Apple IIe Card.”
The double-click exercise

Follow these steps to launch an Apple IIe program by double-clicking its icon.

Before you begin: You'll need one of your own Apple IIe program disks to complete this exercise. Also, your Macintosh should be on, you should be in the Macintosh environment, and you should quit any programs you might be running.

1. If you're a floppy disk startup person, make sure you've started up from the IIe Startup Disk.

   See the instructions in “Starting Up From the IIe Startup Disk,” at the beginning of this chapter.

2. Find one of your Apple IIe program disks.

   If you want to use one of the Macintosh’s built-in disk drives, the program should be on a ProDOS disk and it should not be copy-protected.

3. Insert the disk into a built-in disk drive.

   The disk's icon appears on the desktop.

4. Open the icon of the disk you just inserted.

   Double-click the icon to open it.
5. Choose “by Icon” from the View menu.

6. Double-click the icon of the program you want to run.

   Look for an icon that has a name that ends with the word “SYSTEM.”

After a moment, the program appears on the screen.

7. Use the program as you wish.

8. When you're ready to quit, save your work and return to the Macintosh environment.

   Press Control-8-Esc and click the Quit IIe button.

   In short, you can run Apple IIe programs by double-clicking their icons. (Remember, to see the icons you must be in the Macintosh environment, the program must be on a ProDOS disk, and the program must not be copy-protected.)
Method 2: Restarting the Apple IIe Card

You can also run Apple IIe programs in any of the usual Apple IIe ways. This exercise demonstrates one of these methods.

Before you begin: You'll need one of your own Apple IIe program disks to complete this exercise. Also, your Macintosh should be on, you should be in the Macintosh environment, and you should quit any programs you might be running.

1. If you’re a floppy disk startup person, make sure you’ve started up from the IIe Startup Disk.

   See the instructions in “Starting Up From the IIe Startup Disk,” at the beginning of this chapter.

2. Open your startup disk—the disk at the upper-right corner of your screen—by double-clicking its icon.

3. Double-click the icon of the IIe Startup program.

   ![IIe Startup](image)

   Double-click this icon to switch to the Apple IIe environment.

4. Find one of your original Apple IIe program disks.

   If you want to use one of the Macintosh’s built-in disk drives, the program should be on a ProDOS disk and should not be copy-protected.
5. If there's already a disk in your disk drive (or if you have two disk drives and both are full), press ⌘-Shift-1 to eject a disk.

Press all three keys at once.

6. Insert your Apple IIe program disk into the disk drive.

7. Reset the Apple IIe Card by pressing Control-⌘-Reset.

Press all three keys at once. The Reset key on a typical Macintosh LC keyboard has a triangle on it and is above the top row of keys:

Pressing these three keys resets the Apple IIe Card. When the computer resets, the program on the disk starts.
Using the Option Panel

The next few sections introduce you to the Apple IIe Option Panel. The Option Panel allows you to set Apple IIe options and provides a means of switching between the Apple IIe and Macintosh environments.

* By the way: For more detailed information about the Option Panel, see “Personalizing Your Apple IIe Work Environment” and “Configuring Cards and Slots” in Chapter 5.

Opening and closing the Option Panel

As you’ve seen before, while you’re in the Apple IIe environment you just press Control-Esc to open the Option Panel.

**Before you begin:** Make sure you’re in the Apple IIe environment. You should either have an Apple IIe program or the BASIC prompt (1) on your screen. (If not, double-click the IIe Startup icon.)

1. **If you’re a floppy disk startup person, make sure you’ve started up from the IIe Startup Disk.**

   See the instructions in “Starting Up From the IIe Startup Disk,” at the beginning of this chapter.

2. **Press Control-Esc to open the Option Panel.**

   The Option Panel appears on the screen, as shown in the next step.

   Normally, you would do some work before leaving the Option Panel, but now the first skill you’ll learn is how to return to your Apple IIe work.
3. Click the Continue button.

The Option Panel closes and you return to your Apple IIe work. In short, to open the Option Panel, press Control-Esc; to return to your work, click Continue.
Exploring the Option Panel

In this exercise you learn how the Option Panel works.

Before you begin: Make sure you’re in the Apple IIe environment.

1. Press Control-⌘-Esc to open the Option Panel.

2. Use the large scroll bar to view the different parts of the Apple IIe environment you can control.

3. Click the Memory Card icon.

You may have to use the scroll bar to see the icon. The Memory Card icon is toward the top of the list.

When you click the Memory Card icon, the options you see on the right side of the Option Panel change. Each icon on the left has a different set of options associated with it.
4. Click the General icon at the top of the list.
You may have to use the scroll bar to see the General icon.
When you click the icon you see the options associated with the General icon.

5. Click the Help button at the bottom of the Option Panel.
Information about the General options appears.

6. Click OK to continue.

7. Click "Simple Beep" to change the Apple IIe Card's beep sound.
The computer plays the new sound. Now whenever an Apple IIe program beeps at you, you’ll hear this sound. You can change the beep to any sound you like, though it's a good idea to choose a short beep to avoid delays.

8. Pull down the Apple menu and choose any desk accessory.
For example, you can choose the Alarm Clock or the Control Panel desk accessory.
Whenever you're in the Option Panel you have full access to the Apple menu. That also means that if you're using MultiFinder® you can switch between the Apple IIe environment and any Macintosh programs without quitting either.

9. Close the desk accessory by clicking its close box.

10. Scroll down and click the Mouse Card icon.
The Mouse Card options appear.
11. Click each setting in turn and move the mouse gently back and forth to see what effect it has.

Changing the setting controls how sensitive the pointer is to the mouse's movements. When the setting is slow, a small mouse movement moves the pointer only a very little; when the setting is fast, a small movement moves the pointer much more.

12. Click the setting you like best.
Practicing moving the cards in the Option Panel

In this section, you'll practice moving cards. In the next chapter, you will use these skills to move the cards into the appropriate slots. On your Macintosh LC, you can install and move Apple IIe cards simply by dragging icons on the screen.

Before you begin: Make sure the Apple IIe Option Panel is still displayed on your screen.

1. Scroll down the list of icons and click the Slots icon.

The Slot Configuration panel appears.

In your original Apple IIe computer, you would have had to move the cards by actually opening the case and physically pulling them out and putting them into different slots. With the Option Panel, all you have to do is drag the icons with your mouse. (Wait until the next step to try it.)
2. Use the mouse to drag the Clock icon from slot 2 to slot 4.

Click this icon and while holding down the mouse button... drag it here and release the mouse button.

When you release the mouse button, the two icons switch places and both become gray. (They become gray because the change isn't complete until you restart the Apple IIe Card—but don't worry about that because this is just practice.)

3. Drag the Mouse icon back to slot 4.

The two icons switch back to their original positions.
4. Drag the Clock icon from slot 2 to any spare slot.

The icon moves.

5. Drag the icon back to slot 2.
6. Return to the Macintosh environment by clicking Quit IIe.

After you return to the Macintosh environment, you may notice that you have a new icon:

![IIe Prefs](image)

The IIe Prefs file records the choices that you make in the Option Panel.

---

Managing Apple IIe files

When you're in the Macintosh environment, you can treat Apple IIe programs and other files as if they were ordinary Macintosh files. Follow the steps in this section to see how similar manipulating Apple IIe files is to manipulating Macintosh files.

**Before you begin:** Make sure you're in the Macintosh environment. Quit any programs you might be running. Also, have at hand any of your unlocked old Apple IIe program disks. The disk must be a 3.5-inch ProDOS disk.

1. If you're a floppy disk startup person, make sure you've started up from the IIe Startup Disk.

   See the instructions in "Starting Up From the IIe Startup Disk," at the beginning of this chapter.

2. Insert a 3.5-inch ProDOS Apple IIe program disk into a built-in disk drive.

   You can use any 3.5-inch ProDOS disk so long as it isn't copy-protected.

   🥫 *Don't have an empty disk drive?* Eject a disk by pressing `⌘`-`Shift-1`.

---

Chapter 3: Learning to Use the Apple IIe Card
Even though the disk you inserted is an Apple IIe disk, it appears on the desktop just as Macintosh disks do.

3. **Open the disk by double-clicking its icon.**

   Its window appears.

4. **Choose “by Icon” from the View menu.**

   For example, the *Utilities* disk for the Apple IIe looks like this:

   ![Utilities Disk Window](image)

   - Program files and system files look like this.
   - Other files look like this.

5. **Choose “by Size” from the View menu.**

   The window changes to show a list of all the files. The biggest files are at the top of the list; the smallest at the bottom.

6. **Click the file at the bottom of the list once to select it.**

   You may have to use the scroll bar to find it.

   After you click it, the icon is highlighted.

7. **Choose Duplicate from the File menu.**

   The file is duplicated and the copy’s icon is highlighted.

8. **Drag the icon of the new file to the Trash.**
9. Drag the icon at the bottom of the list to the icon of your startup disk.

Your startup disk is at the top-right corner of your screen.

Dragging the icon causes the file to be copied.

10. If you like, drag the new icon to the Trash.

To see the new icon (so you can drag it to the Trash), you may first have to open your disk by double-clicking its icon.

Naming files on Apple IIe disks

When you’re in the Macintosh environment, you can only give files on Apple IIe disks legal ProDOS names, with two exceptions:

- You can use spaces in the names. When you view a filename that contains spaces in the Apple IIe environment, the spaces are automatically converted to periods. For example, the name “MY FILE” in the Macintosh environment would appear as “MY.FILE” in the Apple IIe environment.

- You can use lowercase letters in the names. When you view a filename that contains lowercase letters in the Apple IIe environment, the letters are automatically converted to uppercase. For example, the name “File” in the Macintosh environment would appear as “FILE” in the Apple IIe environment.

Using Macintosh programs with Apple IIe files

You may be able to use your Macintosh programs to view and edit your Apple IIe files. For example, if you wrote a letter using an Apple IIe program, you might be able to edit the letter with your Macintosh word processor.

For more details, see “Using Apple IIe Files with Macintosh Programs” in Chapter 5.
Before you begin using your Apple IIe Card in earnest, you must go to the Option Panel and set up the cards and slots to reflect your own needs.

In this chapter you will

- decide how you want to arrange your cards and slots
- go to the Option Panel and arrange the cards according to your needs
- set any options required by the cards you've installed
Deciding how to arrange the cards in the Option Panel

In this section, you will plan which Option Panel cards to put in which Option Panel slots. To work properly, Apple IIe programs must know where various cards are installed. For example, in order to print, Apple IIe programs must know where the Printer Card is. Furthermore, some programs may require certain cards to be in certain slots.

Your Apple IIe programs may have special requirements; this section tells you how to convert those special needs into a plan for arranging the cards.

You can go about creating your plan in one of two ways:

- **Base your plan on how accessory cards are installed in your original Apple IIe.** If you have an Apple IIe computer with a number of accessory cards installed, you should arrange the cards in the Option Panel similarly, as described in the following section, “Basing the Plan on Your Original Apple IIe.”

- **Base your plan on the typical arrangement used by a typical Apple IIe user.** If you don’t have an Apple IIe computer or if you prefer to start from scratch, skip ahead to the next section, called “Basing the Plan on a Typical Apple IIe.”
Basing the plan on your original Apple IIe computer, you’ve probably taken care to arrange the cards so that they work well with all your programs. In this section, you will use paper and pencil to write down the way your Apple IIe accessory cards are currently installed and then modify this arrangement to work in your Macintosh LC.

In this section, you only write down your plans. You’ll implement the plans later in this chapter.

1. **Write down the way the accessory cards are arranged in your Apple IIe.**

   For example, one Apple IIe owner may have written the following:

   **Sample User**

   SLOT 1. Super Serial-Printer
   SLOT 2. Super Serial-Modem
   SLOT 3. MONITOR (built-in)
   SLOT 4. Empty
   SLOT 5. Empty
   SLOT 6. Empty
   SLOT 7. Workstation Card

   The third slot in your Apple IIe computer may not have an accessory card installed in it, but even so, it serves as the monitor accessory card.
2. If you have a Super Serial Card connected to a printer, scratch it out and write “Printer Card” instead.

The Printer Card is a special card that allows you to select the printer you want by using the Macintosh Chooser desk accessory.

Sample User
SLOT 1. Super Serial-Printoc. Printer Card
SLOT 2. Super Serial-Modem
SLOT 3. MONITOR (built-in)
SLOT 4. Empty
SLOT 5. Empty
SLOT 6. Empty
SLOT 7. Workstation Card

3. Scratch out the following Apple Ile names and replace them with the new Option Panel names.

<table>
<thead>
<tr>
<th>Original Apple Ile Name</th>
<th>New Option Panel Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple Ile Workstation Card</td>
<td>AppleShare*</td>
</tr>
<tr>
<td>Apple Ile Memory Expansion Card</td>
<td>Memory Card</td>
</tr>
<tr>
<td>Apple Ile Mouse Card</td>
<td>Mouse Card</td>
</tr>
<tr>
<td>UniDisk 3.5 Interface Card</td>
<td>SmartPort</td>
</tr>
<tr>
<td>clock card</td>
<td>Clock Card</td>
</tr>
<tr>
<td>Apple 5.25 Drive Interface Card</td>
<td>5.25 Drive</td>
</tr>
</tbody>
</table>
For example, a user who had the Apple IIe Workstation Card in slot 7 would scratch it out and write in “AppleShare” instead:

```
Sample User
SLOT 1. Super Serial Printer - Printer Card
SLOT 2. Super Serial-Modem
SLOT 3. MONITOR (built-in)
SLOT 4. Empty
SLOT 5. Empty
SLOT 6. Empty
SLOT 7. Workstation Card - AppleShare
```

⚠️ **Important**: Your new Apple IIe Card can provide the functions of almost all the standard Apple IIe accessory cards. Unfortunately, there are a few specialized accessory cards that it cannot replace. If you have an accessory card not mentioned in this section or listed in this table, you won’t be able to install it in the Macintosh LC. ⚠️
4. Fill in empty slots with any unused Option Panel cards you think might be useful.

Unlike the accessory cards for your original Apple IIe, the Option Panel cards are provided at no additional cost, so you should use as many as you can. Use this chart to decide which Option Panel cards would be the most useful; use your Apple IIe program manuals to decide which slots to put them in.

<table>
<thead>
<tr>
<th>Card name</th>
<th>Why you would want to use it</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.25 Drive</td>
<td>To use an Apple 5.25 Drive</td>
</tr>
<tr>
<td>AppleShare</td>
<td>To connect to file servers</td>
</tr>
<tr>
<td>Clock</td>
<td>To give Apple IIe programs access to the date and time</td>
</tr>
<tr>
<td>Memory Card</td>
<td>To increase the amount of memory your Apple IIe programs can use</td>
</tr>
<tr>
<td>Mouse Card</td>
<td>To use the mouse for Apple IIe programs</td>
</tr>
<tr>
<td>Printer Card</td>
<td>To print</td>
</tr>
<tr>
<td>Serial Card (Modem Port)</td>
<td>To connect a device to the modem port of your Macintosh LC</td>
</tr>
<tr>
<td>Serial Card (Printer Port)</td>
<td>To connect a device to the printer port of your Macintosh LC</td>
</tr>
<tr>
<td>SmartPort</td>
<td>To use the built-in floppy disk drive, an Apple UniDisk 3.5 drive, or a hard disk</td>
</tr>
</tbody>
</table>

5. Skip ahead to “Arranging the Cards in the Option Panel” in this chapter.
Basing the plan on a typical Apple IIe

When you first install the Apple IIe Card software, the cards are already installed in one of the most typical arrangements. You should use this arrangement as the basis of your plans. Write it down on a piece of paper (as shown in the figure), and then change it according to the instructions that follow.

**Typical IIe**

- **SLOT 1.** Printer Card
- **SLOT 2.** Clock Card
- **SLOT 3.** MONITOR (built-in)
- **SLOT 4.** Mouse Card
- **SLOT 5.** SmartPort
- **SLOT 6.** 5.25 Card
- **SLOT 7.** Memory Card

Many people can use this basic arrangement just as it is. However, if you have any of the following special requirements, you may have to shuffle the cards, as explained in the next two sections:

- **File servers.** The “File Servers” section explains how to rearrange your cards if you’re connected to a file server.

- **Modems and other serial devices except for printers.** The “Modems and Other Serial Devices Except for Printers” section explains how to rearrange your cards if you’re connected to any non-printer serial device.

If you don’t have either of these special needs, skip to “Setting the Options for Your Cards,” later in this chapter.
File servers

If you want to use a file server, you need the AppleShare card. The AppleShare card is usually installed in slot 7. (See your Apple IIe program manuals to determine whether your programs have different requirements.)

To install the AppleShare card, you’ll have to remove one of the others. Since the AppleShare card typically goes in slot 7, the most tempting card to remove is the Memory Card, which is already there. If you want to move it, here are some suggestions where you might move the Memory Card:

- Slot 2, replacing the Clock Card. If none of your programs use it, you can remove the Clock Card. However, if you have a modem, you’ll probably need slot 2 for the modem port Serial Card.

- Slot 4, replacing the Mouse Card. If none of your programs uses a mouse, you can remove the Mouse Card.

Use this information to change the plans you wrote down earlier.

Modems and other serial devices except for printers

Serial devices are devices, such as a modem, that plug into the printer port or the modem port on the back of the Macintosh.

- Why not printers? The most common serial device plugged into the back of the Macintosh is a printer. However, printers require the special Printer Card, which is already installed into slot 1—so you don’t need to do anything special to arrange to print. The only exception to this rule are old non-Apple serial printers that are commonly used with Apple IIe computers. These printers still require the Serial Cards.

To support a non-printing serial device, you need either of the two serial cards:

- If you have a non-printing device plugged into the modem port, you need the Serial Card with a phone icon on it.
If you have a non-printing device plugged into the printer port, you need the Serial Card with a printer icon on it. (You'll have to make sure AppleTalk is turned off in the Macintosh Chooser to use your device.)

Serial Cards are most commonly placed in slot 2. See your Apple IIe program manuals to determine whether your programs have different requirements.

Use this information to change the plans you wrote down earlier.

Arranging the cards in the Option Panel

Now that you have your plans written down, you'll use the Option Panel to move the cards according to your plan.

**Before you begin:** Make sure your Macintosh LC is turned on and you're in the Macintosh environment. Also, make sure that you've written down your plans as described earlier in this chapter.

1. **If you're a floppy disk startup person, make sure you've started up from the IIe Startup Disk.**

   See the instructions in “Starting Up From the IIe Startup Disk,” at the beginning of Chapter 3.

2. **Double-click the IIe Startup icon.**

   You enter the Apple IIe environment.

3. **Press Control-?Esc to open the Option Panel.**

   The Option Panel appears.

4. **Use the big scroll bar to scroll down until you see the Slots icon.**

5. **Click the Slots icon.**

   The slots and cards are displayed.
6. **Drag the card icons to the slots where they belong.**

   If you don’t know how to move the card icons, see “Practicing Moving the Cards in the Option Panel” in Chapter 3.

   This figure shows the names of the icons:

   ![Diagram of card icons and slots](image)

7. **Click Restart IIe.**

   Your changes don’t go into effect until you restart the Apple IIe.

   ![Restart IIe button](image)

   Your cards are now installed. However, some of the cards you’ve installed may not work until you adjust some of their settings, as explained in the next section.
Setting the options for your cards

Some cards have settings you can adjust. The two Serial Cards require special attention: They won't work until you declare what sort of device is connected to them.

This chapter does not explain how to adjust the settings. That information is available in great detail in Chapter 5, “Reference.” (You can use the index or table of contents to find the exact page numbers.)

However, the following table lists the ten cards you might have installed and describes how you can adjust each one of them (if at all). In most cases, you make the adjustments in the Option Panel.
<table>
<thead>
<tr>
<th>Card</th>
<th>Adjustments you can make in the Option Panel</th>
<th>Other adjustments you can make</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.25 Drive</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>AppleShare</td>
<td>None</td>
<td>Select file servers using the Apple IIe program Chooser II</td>
</tr>
<tr>
<td>Printer Card</td>
<td>Adjust the amount of time your printer has to finish printing</td>
<td>Select which printer you want to use with the Macintosh Chooser desk accessory</td>
</tr>
<tr>
<td>Clock Card</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Memory Card</td>
<td>Adjust the amount of memory your Apple IIe programs can use</td>
<td>None</td>
</tr>
<tr>
<td>Serial Cards</td>
<td>Define the characteristics of the devices attached to your Macintosh computer's modem and printer ports</td>
<td>None</td>
</tr>
<tr>
<td>Monitor Card</td>
<td>Using the General Controls panel, set whether you want text to appear white-on-black or vice versa and declare whether you have a color monitor</td>
<td>None</td>
</tr>
<tr>
<td>Mouse Card</td>
<td>Adjust the responsiveness of your mouse</td>
<td>None</td>
</tr>
<tr>
<td>SmartPort</td>
<td>Determine the scanning order of your floppy disk and hard disk drives</td>
<td>None</td>
</tr>
</tbody>
</table>

⚠️ **Important:** When you click an icon in the Option Panel, if you see a message telling you that its card is not installed in any slot, you must install the card before the changes have any effect. To find out exactly what the problem is, click the Slots icon. If the card you want is not in one of the seven active slots, drag it to the appropriate slot, then click Restart IIe. If the card is already in a slot, clicking Restart IIe will finish installing it. ⚠️
Chapter 5

Reference

This chapter provides instructions for using all the features of the Apple IIe Card and the IIe Startup program.

This is a task-oriented reference chapter. That is, you don’t need to read its sections consecutively. When you need some specific information about using the Apple IIe Card or the IIe Startup program, just look up the task you want to accomplish and follow the step-by-step instructions you find there.

⚠️ Important: If you haven’t learned how to use the Apple IIe Card and the IIe Startup program yet, you might prefer to go first through Chapter 3, “Learning to Use the Apple IIe Card.” Chapter 3 is a tutorial that guides you step by step through some exercises in running Apple IIe programs on the Macintosh LC. ⚠️
Starting up the IIe Startup program

You must start up the IIe Startup program before you can run Apple IIe programs on the Macintosh LC.

To start up the IIe Startup program, follow these steps:

Before you begin: Turn on your Macintosh LC. If your Macintosh is already on, return to the Finder (either by quitting any programs you might be running or by choosing Finder from the Apple menu.)

1. Determine whether you are a floppy disk startup person or a hard disk startup person.

How you set up the software in Chapter 2 determines whether you're a floppy disk or a hard disk startup person. You may have recorded which you are on the Quick Reference card in the back of the manual.

If you can't remember, here's how to tell:

- If you do not have a hard disk you are a floppy disk startup person.
- If you have a hard disk, open the System Folder by double-clicking it. If the System Folder contains a file called “ProDOS File System,” you are a hard disk startup person. Otherwise, you are a floppy disk startup person.

2. If you are a floppy disk startup person, start up your Macintosh LC from the IIe Startup Disk.

To start up from the disk, follow these steps: (a) choose Shut Down from the Special menu, but don’t turn the power off; (b) insert the IIe Startup Disk; (c) use the mouse to click the Restart button.
3. Open your startup disk by double-clicking its icon.

The startup disk is the top icon on the right side of the screen.

4. Double-click the Ile Startup icon to start the program.

The Ile Startup program uses the startup setting in the Slot Configuration panel to locate a program disk. If a specific slot is designated as the startup slot, Ile Startup goes directly to the first drive assigned to that slot. If the startup option is set to Scan, the program scans the slots, in descending order from 7 to 1. The first startup disk it encounters is loaded into the computer's main memory, and you see the opening display for the program on that disk.
If IIe Startup encounters a non-startup disk in the startup drive, you see the message "UNABLE TO BOOT FROM STARTUP SLOT." The program enters the BASIC programming environment and presents the BASIC prompt.

If IIe Startup finds no startup disk in any drive, it enters the BASIC programming environment and presents the BASIC prompt.

See the section "Changing the Startup Device" later in this chapter for more information on designating a startup drive.

Going directly to the Option Panel

If you want the Option Panel to open as soon as the IIe Startup program launches, hold down the Option key just after you double-click the IIe Startup icon. Keep the Option key held down until the Option Panel opens.
Double-clicking the Ile Prefs file

The Ile Startup program creates and maintains a file called the Ile Prefs file, which records all the choices you make in the Option Panel. Double-clicking the Ile Prefs icon causes the computer to switch to the Apple Ile environment, just as double-clicking the Ile Startup icon does.

When you double-click a preferences file, it reads the preferences from that file, which is useful if you have more than one preferences file, as explained in the next section.

Using more than one preferences file

The Ile Prefs file created by the Ile Startup program keeps track of the settings you make in the Apple Ile Option Panel. You choose settings to match the requirements of the Apple Ile programs you run. Normally, one configuration of card and slot settings is sufficient for performing your work. However, if you use two or more programs that require different slot configurations, you can create a separate preferences file for each program. Each preferences file can maintain the configuration of card and slot settings appropriate for a single program, so you won't have to change settings each time you move from one program to another.

Follow these steps to create and maintain more than one preferences file:

1. **Start up the Ile Startup program.**
   - Double-click the Ile Startup icon.

2. **Open the Apple Ile Option Panel (by pressing Control-Alt-Esc).**
3. Select the settings you want to maintain in the first Ile Prefs file.

4. Quit the Ile Startup program (by clicking the Quit Ile button).

5. Rename the first Ile Prefs file.
   
The name you give the file can be anything but “Ile Prefs.” Rename the file in a way that will help you remember its purpose—“Graphics Prefs,” “Charts Prefs,” or “Games Prefs,” for instance.

6. Start up the Ile Startup program and open the Option Panel again.

7. Select the settings you want to maintain in the second Ile Prefs file.

8. Quit the Ile Startup program (by clicking the Quit Ile button).

Each time Ile Startup restarts the Apple Ile Card, it creates a new Ile Prefs file, unless there is already a file named “Ile Prefs” on the disk. You can create as many different preferences files as you want, as long as you keep renaming the most recently created Ile Prefs file. Once you’ve made as many preferences files as you need, you can choose the Ile Prefs file you want to work with by double-clicking its icon to start the Apple Ile Card. As long as you don’t change any settings, the file you start from will remain unchanged when you quit the Ile Startup program.

Starting up an Apple Ile program

You can start up an Apple Ile program either in a standard Macintosh way or in a standard Apple Ile way, whichever is easier for you.
The Macintosh way  When you're in the Macintosh environment, you can start up Apple IIe programs by double-clicking their icons, though this method works only for ProDOS programs.

⚠️ **Important:** You can use this method of starting Apple IIe programs only if you have an empty disk drive while the IIe Startup program is running. In other words, *floppy disk startup people* who have only one internal disk drive cannot use this method. All others can.  ⚠️

**Before you begin:** Your Macintosh should be on. If you're a *floppy disk startup person* you should start up from the IIe Startup Disk, as explained in “Starting Up From the IIe Startup Disk” in Chapter 3.

1. **Find your Apple IIe program.**

   If the program is on your hard disk, open the hard disk and folders so you can see the program’s icon. If the program is on a floppy disk, insert the disk into an empty disk drive and open the disk so you can see the program’s icon.

2. **Double-click the program’s icon.**

   Apple IIe program names often have a period and the word “SYSTEM” after them. Their icons look like this:

   ![Icon](image)

   **SYSUTIL.SYSTEM**

   (To see full-size icons like this one, choose “by Icon” from the View menu.)

   After you double-click, the IIe Startup program opens and your Apple IIe program is launched.
The Apple IIe way When you are in the Apple IIe environment, you start up Apple IIe programs the same way you would on an Apple IIe:

1. **If you have only one disk drive, press X-Shift-1 to eject the IIe Startup Disk from the built-in disk drive.**
   
   If you plan to start up the Apple IIe program from another drive, you don't need to eject the IIe Startup Disk.

   To eject a disk from a second built-in floppy disk drive, press X-Shift-2.

2. **Insert the disk containing the Apple IIe program you want to run into a disk drive.**
   
   If a particular slot has already been designated as the startup slot in the Slot Configuration panel, insert the disk into a drive controlled through that slot.

3. **Press X-Control-Reset.**
   
   Pressing X-Control-Reset resets the Apple IIe Card and restarts the IIe Startup program. IIe Startup uses the startup setting in the Slot Configuration panel to locate a program disk. If a specific slot is designated as the startup slot, IIe Startup goes directly to that slot. If the startup option is set to Scan, the program scans the slots in descending order from 7 to 1. The first startup disk it encounters is loaded into the computer's main memory, and you see the opening display for the program you're running.

   If IIe Startup encounters a non-startup disk in the startup drive, you see the message "UNABLE TO BOOT FROM STARTUP SLOT." The program enters the BASIC programming environment and presents a BASIC prompt.
If IIE Startup finds no startup disk in any drive, it enters the BASIC programming environment and presents a BASIC prompt.

From the BASIC programming environment, you can start up a program disk by typing a BASIC instruction that directs IIE Startup to the disk drive you indicate.

4. Type `pr#` followed by the number of the slot to which the startup drive is assigned.

   The most typical instructions are `pr#5` for 3.5-inch disk drives and `pr#6` for 5.25-inch disk drives.

Printing from Apple IIE programs

To print Apple IIE files, use the programs' print commands just as you would if you were using an Apple IIE. When you print through the Printer Card, you should set your Apple IIE program to treat the printer as if it's an ImageWriter II, even if it's not.

Choosing a printer

To select the printer you want to use, or to change printers, use the Macintosh desk accessory called the Chooser.

Before you begin: Your Macintosh should be on. If you're a floppy disk startup person you should start up from the IIE Startup Disk, as explained in “Starting Up From the IIE Startup Disk” in Chapter 3.

1. If you're in the Apple IIE environment, open the Option Panel by pressing Control-8-Esc.

   If you're in the Macintosh environment, you need do nothing.

2. Select the Chooser from the Apple menu.
3. Click the icon that represents the kind of printer you want to use. 

If your Chooser window looks different, you may have to use the scroll bar to see all these choices.

- **Your printer isn’t there?** If the kind of printer you want to use isn’t in the Chooser, you need to install the printer software. Turn now to Appendix E, “Installing Printer Software for the **IIe Startup Disk.”**

4. If the printer is connected over a network, you’ll have to select the printer you want and perhaps also the zone it’s in.

See the reference book that came with your Macintosh for more information on using the Chooser.

5. **Choose Close from the File menu.**

6. **If you’re in the Option Panel, click the Continue button.**
Using Apple IIe files with Macintosh programs

Sometimes you may wish to transfer information from Apple IIe programs to Macintosh programs. You can do so, provided you can find a file format that both programs understand or you have a Macintosh program that can read Apple IIe files directly.

For example, say you typed a long text passage using an Apple IIe program and now you want to use the same text in a speech you're writing using a powerful Macintosh word processor. Most word processors can read "text-only" files (also called ASCII files). To transfer the text, you could (a) use an Apple IIe program to save the file in text-only format, then (b) use the Macintosh program to open the file.

In general, follow these steps:

Before you begin: Your Macintosh should be on. If you're a floppy disk startup person you should start up from the IIe Startup Disk, as explained in "Starting up From the IIe Startup Disk" in Chapter 3.

1. Check the manuals of both the Apple IIe and Macintosh programs to determine what file format, if any, the two programs share.

   Typical file types that Apple IIe and Macintosh programs might share depend on what the programs do. For example, spreadsheet programs might share a tab-delimited type and word processing programs might share a text-only type.

   Unfortunately, you may not find shared file formats to exchange pictures. If you can't find one, see the next section, "Copying Apple IIe Pictures," which offers an alternative strategy.

2. Open the Apple IIe file using an Apple IIe program.

   Switch to the Apple IIe environment and use your Apple IIe program to open the file.

3. Save the file in the shared format, giving it a new name.

   See the program's instructions for information on how to save files in different formats.
4. Return to the Macintosh environment.

Press Control-⌘-Esc and click the Quit IIe button.

5. Open the Macintosh program you want to use.

6. Choose the Open command from the File menu.

7. Use the Open dialog box to select the Apple IIe file.

Click the Drive button to select the correct disk and double-click folders to open them. For more information on using the Open dialog box, see the reference book that came with your Macintosh.

*Can't see your file?* If you can’t see the file, you may not be looking in the correct folder or on the correct disk. If you are, you may not have saved the Apple IIe file in a format that your Macintosh program can understand. Some Macintosh programs have special ways of opening so-called “foreign” files. See the manual that came with the Macintosh program for more details.

### Copying Apple IIe pictures

If you want to transfer an Apple IIe picture to a Macintosh program, you can copy and paste the picture as described in these steps:

1. Use your Apple IIe program to display the picture on your screen.

2. Save your work, if necessary.

3. Press Control-⌘-Esc to open the Option Panel.

   The Option Panel opens.
4. Choose the Copy IIe Screen command from the Edit menu.

5. Click the Quit IIe button.
   When asked if you really want to quit, click Quit IIe again.

6. Open the Macintosh file in which you want to place the picture.

7. Choose the Paste command from the Edit menu.
   The picture is pasted in.

If you have more than one Apple IIe picture to transfer at the same time, you may wish to use the Macintosh desk accessory called the Scrapbook. For more information, see the reference book that came with your Macintosh.

Using network file servers

If your Macintosh LC is connected to a file server over a network, you can use it just as you did with your original Apple IIe: you can start up from the file server and access files on it, as the next two sections explain.

Starting up from the file server

With your Apple IIe computer, you could start up from a file server. When you’re in the Apple IIe environment, you can do the same with your Macintosh LC and your Apple IIe Card. In fact, the method is the same as before.

Before you begin, make sure the following preparations have been made:

- Your network administrator, the person who installs and maintains your network and your file server, has connected everyone to the network and prepared the file server as described in the instructions that come with the AppleShare Workstation Card and the AppleShare File Server 2.0.
- You have used the Option Panel to install the AppleShare card into one of the slots, as explained in Chapter 4, "Setting Up Cards and Slots."

- You have set the startup device either to Scan or to the slot in which the AppleShare card is installed. The AppleShare card is usually installed in slot 7.

From now on, whenever you start or restart the Apple Ile, you'll follow the usual network log-on procedure, as described in the instructions that come with the AppleShare Workstation Card and the AppleShare File Server 2.0.

Using Apple Ile files on a network file server with a Macintosh LC and the Apple Ile Card is the same as using them on an Apple Ile computer. You simply use the Logon program, as described in the instructions that come with the AppleShare Workstation Card.
You use the Apple IIe Option Panel to adjust some aspects of the Apple IIe Card's operation. Most of the adjustments are made in the General Controls panel, the panel that appears automatically whenever you open the Option Panel.

Most of the settings in the General Controls panel take effect immediately and remain active whenever you start up the IIe Startup program, until you change them again.

You can change the processing speed of the Apple IIe Card. The Option Panel provides two Speed settings: normal and fast. The Normal setting represents the normal processing speed for an Apple IIe computer. The Fast setting is up to twice as fast as the Normal setting. (The actual speed varies among programs, depending on a number of factors—principally, the amount of graphics processing a program requires.)

Depending on the type of program you're running, you may benefit from changing the Speed setting. For instance, a spreadsheet program would benefit from the added processing speed by performing calculations more quickly. Other programs, however, may be less effective running under the Fast setting. For instance, many games may run too quickly. And programs that require precise time-interval measurements—such as music programs—may need the normal Apple IIe processing speed to run properly.

If you're uncertain what Speed setting is most appropriate for the program you want to run, try the Fast setting first. If the program doesn't run as expected, change the setting back to Normal.
To change processing speed, follow these steps:

1. **Press Control-x-Esc.**

The Option Panel appears, with the General Controls panel displayed. The pointer changes to a crosshair when you place it in the General Controls panel.

![Diagram of the Option Panel with General Controls panel highlighted. The pointer is a crosshair. Choose a processing speed here.](#)
2. Click the button for the speed you want.

When you close the Apple IIe Option Panel, you see a message indicating that the changes you made in the General Controls panel will not take effect until you restart the Apple IIe Card.

![Message: Changes in General panel will not take effect until restart. Do you want to continue anyway?]

3. Click the Restart IIe button to restart the Apple IIe Card.

The Apple IIe Card restarts, with the new Speed setting in effect.

If you don't want the new setting to take effect yet, click the Continue button.

⚠️ Warning: Be sure to save your work on a floppy disk before clicking the Restart IIe button. Any work that has not been saved on a disk will be lost.⚠️

Choosing a startup beep sound

Your computer beeps when you start up the Apple IIe Card. Also, many programs are designed to play a sound when an alert message is displayed, or when you give a command that the computer cannot recognize.

You can choose one of several options for the beep sound. You can choose the same beep sound you hear on an Apple IIe computer, the standard Macintosh beep, or any other sound that appears in the Startup Beep Sound box. To avoid annoying delays, it's a good idea to choose a short sound. The Apple IIe Option Panel is preset to use the standard Apple IIe beep.
To choose a startup beep sound, follow these steps:

1. **Press Control-⌘-Esc.**

The Option Panel appears, with the General Controls panel displayed. The pointer changes to a crosshair when you place it in the General Controls panel.

If you are a floppy disk startup person, you have only two beeps to choose from.
2. Scroll if necessary to find the name of the beep sound you want, then click the name.

The sounds displayed in the box represent the sound files contained in the Macintosh System file. Any sound you add to your Macintosh System file is available as an Apple IIe beep.

When you release the mouse button, the selected sound plays.

After you close the Option Panel, your choice remains in effect until you choose a different beep sound.

⚠️ **Important:** If the speaker volume setting in the Macintosh Control Panel is set to zero (that is, if it is turned off), the computer will not beep while in the Apple IIe environment. ⚠️

Setting the keys' repeat rate

On all Macintosh keyboards, holding down a character key causes the character to appear repeatedly on the screen until you release the key. You can adjust the rate of repetition from very slow to quite fast. (To turn off the key repeat option, see the next section, “Setting the Delay Before Keys Repeat.”)

The repeat rate you choose in the Apple IIe Option Panel is in effect only while the computer is in the Apple IIe environment. When you switch to the Macintosh environment, the repeat rate is determined by the key repeat rate setting in the Macintosh Control Panel.

The key repeat rate in the Apple IIe General Controls panel is preset to the rate setting in the Macintosh Control Panel.
To set the key repeat rate, follow these steps:

1. **Press Control-\^E-Esc.**

   The Option Panel appears, with the General Controls panel displayed. The pointer changes to a crosshair when you place it in the General Controls panel.

![Option Panel screenshot](image)

   Choose a key repeat rate here.

2. **Click the button for the repeat rate you want.**

   After you close the Option Panel, your choice remains in effect until you change the setting again.

---

**Setting the delay before keys repeat**

You can adjust the keyboard's operation to your "touch" by setting the delay before a character begins repeating when a key is held down. You can also turn off the key repeat feature entirely.

The delay setting you choose in the Apple IIe Option Panel is in effect only while the computer is in the Apple IIe environment. When you switch to the Macintosh environment, the delay is determined by the delay setting in the Macintosh Control Panel.
The delay setting in the Apple IIe General Controls panel is preset to the delay setting in the Macintosh Control Panel.

To set the delay until a character repeats when a key is held down, follow these steps:

1. **Press Control-⌘-Esc.**

   The Option Panel appears, with the General Controls panel displayed. The pointer changes to a crosshair when you place it in the General Controls panel.

2. **Click the button for the repeat delay you want.**

   Clicking the Off button turns off the key repeat feature.

   After you close the Option Panel, your choice remains in effect until you change the setting again.
Changing the Type Ahead setting

You use the Type Ahead feature to type text and commands while the Apple Ile program is busy with some other activity. Even though you may not see the text immediately on the screen, what you type is stored in a type-ahead buffer, an area of memory reserved for keeping track of what you type.

Some programs do not perform correctly when the Type Ahead feature is on. If the keyboard seems unresponsive in a particular program, or if certain keys don't work as expected, try turning the Type Ahead feature off.

To change the Type Ahead setting, follow these steps:

1. **Press Control-\%-Esc.**

   The Option Panel appears, with the General Controls panel displayed. The pointer changes to a crosshair when you place it in the General Controls panel.
2. Click the button for the setting you want.

Clicking the Off button turns off the Type Ahead feature; clicking the On button turns it on.

After you close the Option Panel, your choice remains in effect until you change the setting again.

Changing the Display setting

If you have a color monitor, you can choose between a color or monochrome display. Even with a color monitor, however, there are times when working in monochrome is an advantage. First, because of the manner in which the Apple IIe produces color, you may see “color fringing” — a slight color cast around the edges of text characters. If so, switching to monochrome avoids the problem.

You cannot choose the Color setting in the Apple IIe Option Panel if the Macintosh display is set to Black and White in the Macintosh Monitors Control Panel. If you want to use a color display in the Apple IIe environment, you must have the Macintosh display set to color.

► By the way: You can improve the computer’s processing performance in the Apple IIe environment if you set the Macintosh Monitors control panel to Black and White. ►
To change the Display setting, follow these steps:

1. **Press Control-\(\text{Esc}\).**

   The Option Panel appears, with the General Controls panel displayed. The pointer changes to a crosshair when you place it in the General Controls panel.

2. **Click the button for the setting you want.**

   After you close the Option Panel, the Display setting you chose remains in effect until you change the setting again.
Changing the character set

Apple IIe programs normally display text with a light character set on a dark background. You can change this to dark text on a light background by choosing the inverse character set.

To change the character set, follow these steps:

1. **Press Control-\textasciicircum-Esc.**

   The Option Panel appears, with the General Controls panel displayed. The pointer changes to a crosshair when you place it in the General Controls panel.

   ![Option Panel](image)

   Choose a character set here.

2. **Click the button for the character set you want.**

   After you close the Option Panel, your choice remains in effect until you change the setting again.

   - *By the way:* Regardless of which character set you choose, flashing text appears as black characters on a red background on a color monitor, or dark characters on a light background on a monochrome monitor.
Changing or adding an Option Panel key

You can always open the Option Panel by pressing the combination keystroke Control-38-Esc. If you like, you can add a second key or combination of keys to open the Option Panel.

To add a second way of opening the Option Panel, follow these steps:

1. **Open the Option Panel by pressing Control-38-Esc.**

   The Option Panel appears, with the General Controls panel displayed. The pointer changes to a crosshair when you place it in the General Controls Panel.

2. **Click the Change button.**

   A dialog box appears.

3. **Press the key or combination of keys you want to use to open the Option Panel.**

   If instead you want to remove the second Option Panel Key, click the None button.

4. **Click OK.**
Changing the mouse tracking rate

You can adjust the correlation between mouse and pointer movement, called *mouse tracking*, so that the pointer moves the same distance on the screen as the mouse moves, or so that the pointer moves up to two times as far on the screen as the mouse moves, depending on how fast you move the mouse.

The mouse tracking rate you choose in the Apple IIe Option Panel is in effect only while the computer is in the Apple IIe environment. When you switch to the Macintosh environment, the mouse tracking rate is determined by the rate setting in the Macintosh Control Panel.

The mouse tracking rate in the Apple IIe Option Panel is preset to the rate setting in the Macintosh Control Panel.

The options for tracking are

- **Slow**—the mouse and the pointer move the same distance
- **Fast**—the pointer moves twice as far as the mouse
- **Buttons between Slow and Fast**—gradations between one-for-one and two-for-one pointer and mouse movements
- **Very Slow/Tablet**—the pointer moves at a constant speed when the mouse is moved, a useful setting for drawing with the mouse or using a graphics tablet

To change the mouse tracking rate, follow these steps:

1. **Press Control-§-Esc**.

   The Option Panel appears, with the General Controls panel displayed.
2. Scroll if necessary to locate the Mouse Card icon, then click it to display the Mouse Card panel.

The Mouse Card panel appears. The pointer changes to a crosshair when you place it in the panel.

3. Click the button for the tracking speed you want.

The new tracking speed takes effect immediately; you can test it by moving the mouse.

After you close the Option Panel, your choice remains in effect until you choose a different tracking speed.
Configuring cards and slots

Many Apple IIe programs are designed to look for certain kinds of hardware, or cards, in specific locations, or slots, in the computer. Since the Macintosh LC isn't an actual Apple IIe, it doesn't provide these slots, nor does it contain the cards. Instead, the Macintosh LC uses software representations of the slots and cards to simulate the hardware configurations of an Apple IIe.

The settings in the Apple IIe Option Panel are preset to the configurations most commonly used by Apple IIe programs. You may never need to change any of these settings.

Changing the Memory Expansion Card size

Many Apple IIe programs work more efficiently with access to additional memory. The Apple IIe Option Panel lets you add additional memory by designating a portion of the Macintosh LC computer's available memory for Apple IIe programs. Apple IIe programs interpret this extra memory as an Apple II Memory Expansion Card.

The Memory Expansion Card panel lets you set the size of the Apple II Memory Expansion Card. The size may be set in 256K increments up to a maximum size of 1024K (1 megabyte).

Before you begin: Your Macintosh should be on. If you're a floppy disk startup person you should start up from the IIe Startup Disk, as explained in “Starting Up From the IIe Startup Disk” in Chapter 3.

1. If you are in the Apple IIe environment, return to the Macintosh environment.
   
   Save your work, then press Control-Esc and click Quit IIe.

2. Select the IIe Startup icon by clicking it once.
   
   The icon is highlighted.
3. Choose the Get Info command from the File menu.

The Info window opens.

4. Press Tab to select the Application Memory Size.

5. Type the new Application Memory Size, which you can calculate as follows:

Take the number you would like to put in the Memory Card and add 512 to it. For example, if you would like to have the card size set to 1024, type 1536. (In any case, don't set the size to be less than the suggested size of 768 K.)

6. Double-click the Ile Startup icon to go into the Apple Ile environment.

If you get a message saying you don't have enough memory, you've set the application memory size too high. Try again using a smaller number.

7. Press Control-⌘-Esc to open the Option Panel.
8. Click the Memory Card icon to display the Memory Expansion Card panel.

The Memory Expansion Card panel appears. The pointer changes to a crosshair when you place it in the panel.

- **Warning message:** If you get a message telling you the Memory Card is not installed, you can continue with this section, but changing the memory will not have any effect until you install the Memory Card, as explained in "Changing the Slot Settings," later in this chapter.

9. Click the small up and down arrows to change the size of the card, as you planned in step 5.

10. Click the Restart Ile button to restart the Apple Ile Card.

The Apple Ile Card restarts, with the new Memory Expansion Card setting in effect.

If you see a message telling you there wasn't enough memory to install the Memory Expansion Card, you either set too high a number in the Option Panel or too low a number in the Info window. Try again.
Setting the Serial Cards

The Macintosh LC has two serial ports on the back of the computer, one marked with a picture of a printer and one marked with a picture of a telephone. They are called the printer port and the modem port.

Despite the names, you can plug any serial device into either port. The Option Panel has two icons for Serial Cards (called Super Serial Cards in the Apple IIe world), one representing whatever is plugged into the modem port and the other representing whatever is plugged into the printer port.

⚠️ Important: In general, you shouldn’t use either Serial Card for your printer, even if the printer is plugged into one of these ports. Instead, use the Printer Card. ⚠️

The changes you make to the settings for either Serial Card take effect only if that card is installed in an active slot. Neither Serial Card is installed in an active slot when you first install the Apple IIe Card software.

⚠️ Note: The illustrations in this section show how to change settings in the Serial Card for the modem port. The steps are exactly the same for changing the settings in the Serial Card for the printer port. ⚠️
To change the settings, follow these steps:

1. To open the Option Panel, press Control-⌘-Esc.

   The Option Panel appears, with the General Controls panel displayed.

2. Scroll if necessary to locate the Serial Card icon representing the port your device is plugged into.

   If the device you want to configure is plugged into the modem port, click the modem port icon; if the device is plugged into the printer port, click the printer port icon. Remember, if the device is a printer, you should be using the Printer Card, not a Serial Card.

   ![Serial Card icons](image)

   ![Select a device here.](image)

   - Warning message? If you get a message telling you the Serial Card is not installed, you can continue with this section, but changing the settings will not have any effect until you install the Serial Card in an active slot, as explained in “Changing the Slot Settings,” later in this chapter.
3. Click the button for the device you want to assign to this Serial Card.

Clicking either of the top two buttons—Apple Data Modem 2400 or Apple Personal Modem 1200—automatically sets the serial card parameters. If you click the Other button, the Port Characteristics box in the lower portion of the panel becomes active.

Port Characteristics

<table>
<thead>
<tr>
<th>Baud Rate: 1200</th>
<th>Auto Line Feed: Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Format: 8 Data / 1 Stop</td>
<td>Interrupts: Off</td>
</tr>
<tr>
<td>Parity: None</td>
<td>Serial Card Mode: Modem</td>
</tr>
<tr>
<td>Line Length: 80 Characters</td>
<td>Handshaking: XON/XOFF</td>
</tr>
</tbody>
</table>

Use this part of the panel to select the settings required by the device you're connecting. (See the manual that came with the device for the appropriate settings.)

4. For each setting you want to change, position the pointer over the small triangle to the right of the setting, and then press the mouse button.

A pop-up menu of settings appears with the current setting highlighted.
5. Drag through the menu until the setting you want is highlighted, then release the mouse button.

The setting you choose appears in the box.

6. Click the Restart IIe button to restart the Apple IIe Card.

The Apple IIe Card restarts, with the new slot settings in effect.

If you don't want the new settings to take effect yet, click the Continue button.

⚠️ Warning: Be sure to save your work on a floppy disk before clicking the Restart IIe button. Any work that has not been saved on a disk will be lost. ⚠️

Using modems at speeds higher than 1200 baud

The maximum baud rate at which you can transmit data using Apple IIe communication programs with the Apple IIe Card varies from program to program. If you use modems at a baud rate of 2400 or above and experience problems receiving data (if data is missing after a transmission, for instance), you may be able to solve the problem and still use a higher baud rate by opening the Option Panel and selecting Monochrome in the General Controls panel.

Making changes to the Printer Card

If you are connected to a printer, even if the printer is connected over a network, you should install the Printer Card.

The only change you can make to the Printer Card is to extend printer timeout. Doing so allows your Apple IIe programs more time to finish printing before the computer lets another document print.
Extending printer timeout

To extend printer timeout, follow these steps:

1. **Press Control-⌘-Esc** to open the Option Panel.

2. **Click the Printer Card.**

   The Printer Card panel appears. The pointer changes to a crosshair when you place it in the panel.

3. **Click the Extend Printer Timeout checkbox** so that an X appears in the box.

   -延展印表机超时
Choosing a printer

You do not use the Printer Card to choose your printer. Instead, use the Macintosh desk accessory called the Chooser. For details, see “Printing From Apple IIe Programs,” earlier in this chapter.

Changing the slot settings

The Slot Configuration panel is where you indicate the location of Apple IIe cards. These are not real cards installed in the Macintosh LC. They are software representations of cards that are commonly installed in Apple IIe computers. The settings you make in this panel provide the information necessary for most Apple IIe programs to run correctly on the Macintosh LC.

The slot settings are preset to the most common slot configurations recommended in Apple II documentation. Some cards can only be installed in a specific slot. For instance, the SmartPort Card is always in slot 5; the 5.25-inch disk drive controller card is always in slot 6. If you try to move such a card to a slot where it does not belong, the program will alert you with a dialog box.

- Where should the cards go? See Chapter 4, “Setting Up Cards and Slots,” for a discussion of how to decide which cards should go in which slots.

When you change a slot setting in the Slot Configuration panel, the icon representing the card you moved appears dimmed. This indicates that the new setting is inactive until you click the Restart IIe button.
To change a slot setting, follow these steps:

1. **Press Control-⌘-Esc.**
   
The Option Panel appears, with the General Controls panel displayed.

2. **Scroll if necessary to locate the Slots icon, then click it to display the Slot Configuration panel.**
   
The Slot Configuration panel appears. The pointer changes to a crosshair when you place it in the panel.

3. **Drag the icon of the card you want to move to its new location.**
   
   When you release the mouse button, the icon appears in the new slot.

   If another icon is already in that slot, it exchanges places with the first icon when you release the mouse button.
4. Click the Restart Ile button to restart the Apple Ile Card.

The Apple Ile Card restarts, with the new slot settings in effect.

If you don't want the new settings to take effect yet, click the Continue button.

⚠️ Warning: Be sure to save your work on a floppy disk before clicking the Restart Ile button. Any work that has not been saved on a disk will be lost. ⚠️

Changing the startup device

Whenever you start or restart the Apple Ile Card, it scans all the available disk drives for a program disk, if you've set it to do so. If you've designated a particular disk drive as the startup drive, the Apple Ile Card goes directly to that drive.

When the Apple Ile Card is set to scan all available disk drives, it scans the slots—in descending order from slot 7 to slot 1—for a disk drive containing a startup disk. If you always start up from the same drive, you can save time by changing the startup setting to the particular slot number assigned to that drive. After you've made the setting active (by clicking the Restart Ile button), the next time you start up a program, the Apple Ile Card goes directly to the slot you've chosen.

To change the startup setting, follow these steps:

1. Press Control-⌘-Esc.

The Option Panel appears, with the General Controls panel displayed.
2. Scroll if necessary to locate the Slots icon, then click it to display the Slot Configuration panel.

The Slot Configuration panel appears. The pointer changes to a crosshair when you place it in the panel.

3. Position the pointer over the small triangle to the right of the Startup setting, and then press the mouse button.

A pop-up menu of settings appears with the current setting highlighted.
4. Drag through the menu until the slot you want is highlighted, then release the mouse button.

   The setting you choose appears in the box.

5. Click the Restart IIe button to restart the Apple IIe Card.

   The Apple IIe Card restarts, with the new slot settings in effect.

   If you don't want the new settings to take effect yet, click the Continue button.

⚠️ Warning: Be sure to save your work on a floppy disk before clicking the Restart IIe button. Any work that has not been saved on a disk will be lost. ⚠️

Saving time by making 5.25 Drives inactive

Some Apple IIe programs scan all the disk drives connected to your computer whenever they need to write information on a disk. If you have one or more 5.25 Drives connected to your computer, these programs will start up each 5.25 Drive, even when the drives are empty. When you are not working with 5.25-inch disks, you can speed up your work by temporarily disabling your 5.25 Drives. To do so, open the Apple IIe Option Panel, and click the Slots icon to open the Slot Configuration panel. Then drag the icon representing the disk controller card from slot 6 to a Spare Card slot. This makes the drives controlled through slot 6 (that is, all the 5.25 Drives connected to your computer) inactive. You must click Restart IIe to make the change take effect. To make the drives active again, drag the icon from the Spare Card slot back to slot 6.
Changing the SmartPort settings

SmartPort is the feature that lets you use 3.5-inch disk drives to run Apple IIe software. Apple IIe programs access all 3.5-inch drives—whether built-in disk drives or UniDisk 3.5 Drives connected to the Macintosh LC—through SmartPort.

SmartPort also increases the number of drives accessible per slot in the Apple IIe. The ProDOS operating system can normally access only two disk drives per slot. However, with a SmartPort device in slot 5, ProDOS can “borrow” two slot assignments from slot 2, provided there are no storage devices in slot 2.

You can have up to four disk drives in active slot/drive locations. But only one SmartPort device can be the startup device: the device in slot 5 drive 1. You change your startup drive by moving a disk drive icon from another slot/drive assignment into slot 5 drive 1.

Although you can place disk drive icons in any slot and drive, SmartPort automatically fills any gaps in the drive assignments, from left to right. SmartPort does not allow any empty slots between disk drive icons.

To change the SmartPort drive and slot assignments, follow these steps:

1. **Press Control-36-Esc.**

   The Option Panel appears, with the General Controls panel displayed.
2. Scroll if necessary to locate the SmartPort icon, then click it to display the SmartPort panel.

The SmartPort panel appears. The pointer changes to a crosshair when you place it in the panel.

3. Drag the icon of the device you want to move to its new location.

If another icon is already in that location, it exchanges places with the first icon when you release the mouse button.

When you release the mouse button, the icon appears in the new slot/drive location.
4. Click the Restart IIe button.

The Apple IIe Card restarts, with the new SmartPort settings in effect.

**Warning:** Be sure to save any work on floppy disks before clicking the Restart IIe button. Any work that has not been saved on disks will be lost. ▲

**Ejecting disks**

To eject disks from their drives, use the Eject buttons. Two Eject buttons appear in the bottom-left corner of the Apple IIe Option Panel. Either one or both buttons are active, depending on the number of disk drives you have in your computer system.

- If your Macintosh LC contains only one built-in floppy disk drive, only the right Eject button is active. The other button is dimmed.
- If your Macintosh LC contains a second built-in floppy disk drive, both Eject buttons are active. The left button represents the second built-in drive.

To eject a disk from an external floppy disk drive connected to your Macintosh LC, press the Disk Eject button on the UniDisk 3.5 Drive, or open the disk drive door on the Apple 5.25 Drive.
To eject a disk from a built-in disk drive, follow these steps:

1. Press Control-\&-Esc.

   The Option Panel appears, with the General Controls panel displayed.

   ![Option Panel](image)

   (A dimmed button means you have only one disk drive.)

2. Click the Eject button for the disk drive that contains the disk you want to eject.

   Click the right Eject button to eject a disk from the first (rightmost) built-in drive; click the left Eject button for the second (leftmost) drive.

   The disk is ejected.

Another way to eject disks is to use a combination keystroke. Pressing \&-Shift-1 ejects a disk from the first built-in floppy disk drive; pressing \&-Shift-2 ejects a disk from the second built-in floppy disk drive, if your Macintosh LC contains one.
Navigating in the Apple IIe environment

You use the Apple IIe Option Panel to navigate through the Apple IIe environment, and between the Apple IIe environment and the Macintosh desktop.

Opening the Option Panel

To open the Option Panel from the Apple IIe environment, you must press three keys at once: the Control key, the ⌘ (Command) key, and the Escape key. This key combination is usually written Control-⌘-Esc. On typical Macintosh keyboards, all three keys are on the bottom row.

A shortcut for opening the Option Panel from the Macintosh environment

If you want the Option Panel to open as soon as the IIe Startup program launches, hold down the Option key just after you double-click the IIe Startup icon. Keep the Option key held down until the Option Panel opens.

Limiting access to the Option Panel

If you need to protect the Apple IIe Option Panel—in school labs or in work areas where several users share the same computer, for instance—you can do so in one of three ways, as explained in the next three sections.

Locking the preferences file

While the preferences file is locked, users will not have access to any of the panels used to change Option Panel settings, though they can still click the Option Panel buttons. You can lock and unlock the preferences file as often as you like.
To lock the IIe Prefs file, follow these steps:

**Before you begin:** Make sure you’re in the Macintosh environment.

1. Select the IIe Prefs file by clicking its icon once.
2. Choose Get Info from the File menu.
3. Click the Locked checkbox until an X appears in it.
   Click the close box.

Purchasing and installing an optional jumper cable

To protect the Option Panel settings more permanently, you can purchase an optional jumper to use with the Apple IIe Card. Once your dealer installs the jumper on the Macintosh LC logic board, users will still have access to the Apple IIe Option Panel buttons, but they will not have access to any of the panels used to change Option Panel settings. See your authorized Apple dealer for more information.

Hiding the preferences file

To prevent someone from accidentally throwing away the IIe Prefs file, you can move the file to the System Folder on your startup disk.

If you’re a floppy disk startup person, drag the IIe Prefs file into the System Folder on the *IIe Startup Disk*; if you’re a hard disk startup person, drag the file into the System Folder on your hard disk.
Returning to your work  

After you're finished with the Apple IIe Option Panel, you can return to what you were doing before you opened the Option Panel—running a program or utility, writing a program, and so on—by clicking the Continue button.

Some Option Panel settings take effect only after you restart the Apple IIe Card. If you changed any such settings, you see a message after clicking Continue. The message reminds you to restart the Apple IIe Card if you want the new settings to take effect.

To return to your work, follow these steps:

Click here to return to your Apple IIe work.
1. From the Option Panel, click the Continue button.

You return to where you were before opening the Apple IIe Option Panel.

or

You see a message indicating that the Option Panel settings you made will not take effect until you restart the Apple IIe Card.

![Warning message]

The changes you have made in the "Slots" panel will not take effect until restart. Do you want to continue anyway?

[Cancel] [Restart IIe] [Continue]

2. If you see a message, click the button for the action you want to take.

Clicking the Restart IIe button restarts the Apple IIe Card.

Clicking the Continue button returns you to what you were doing before opening the Option Panel; the new settings will not take effect until you restart at a later time.

Clicking the Cancel button returns you to the Apple IIe Option Panel; the new settings will not take effect until you restart at a later time.
Restarting the Apple IIe Card

Clicking the Restart IIe button performs a “cold” reset of the Apple IIe Card. Clicking the Restart IIe button has the same effect as pressing ⌘-Control-Reset on the original Apple IIe keyboard, except that clicking the Restart IIe button also causes any changes you made in the Option Panel to take effect.

Clicking the Restart IIe button is only one way to restart the Apple IIe Card. Whenever the Macintosh LC is in the Apple IIe environment, pressing ⌘-Control-Reset immediately resets the Apple IIe Card.

The Reset key on a typical Macintosh LC keyboard has a triangle on it and is placed above the top row of keys:

⚠️ Warning: Use ⌘-Control-Reset with caution. When you press ⌘-Control-Reset, the Apple IIe Card resets immediately, without warning you to save your work on a floppy disk. Pressing ⌘-Control-Reset from the Apple IIe Option Panel, or in the Macintosh environment, immediately restarts your Macintosh LC—with no warning to save your work. ⚠️
To restart the Apple IIe Card, follow these steps:

1. Press Control-~-Esc.

   The Option Panel appears, with the General Controls panel displayed.

   ![Option Panel](image)

   Click this button to restart the Apple IIe Card.

2. Click the Restart IIe button.

   The Apple IIe Card restarts.
Quitting the Apple IIe environment

At any time while you're in the Apple IIe environment, you can quit the Apple IIe environment and return to the Macintosh desktop by opening the Option Panel and clicking the Quit IIe button.

To quit the Apple IIe environment, follow these steps:

1. Press Control-36-Esc.

The Option Panel appears, with the General Controls panel displayed.
2. **Click the Quit Ile button.**

You see a dialog box reminding you that any work you haven’t saved will be lost.

![Dialog Box]

3. **Click the Quit Ile button.**

You return to the Macintosh desktop.

Clicking the Cancel button cancels the quitting and returns you to the Apple Ile Option Panel. It does *not* cancel any changes you may have made in the Option Panel.

*By the way:* You can also quit the Apple Ile environment while using the Option Panel by pressing `⌘-Q`.

---

**Using the Apple Ile Card with MultiFinder**

MultiFinder is a Macintosh feature that allows you to run more than one Macintosh program at a time. See the reference manual that came with your Macintosh LC for general information about how to turn on MultiFinder and how to use it.

This section explains how to switch to other programs when MultiFinder is on. Follow these steps:

1. **Press Control-⌘-Esc to open the Option Panel.**
2. Pull down the Apple menu and choose the program you want to switch to.

   ![Apple menu]

   This section of the Apple menu lists the programs you can switch to.

3. When you're ready to return to your Apple IIe work, pull down the Apple menu and choose IIe Startup.

   The Option Panel is displayed.

4. Click Continue to resume your work.
Getting help

If you need help while using the Option Panel, use the Help button. Clicking the Help button displays a window that explains the purpose of the active panel and tells you how to choose the settings in that panel.

To get help while using the Apple IIe Option Panel, follow these steps:

1. From the Option Panel, click the Help button.

   The Help window for the active panel appears.

   ![Option Panel Help Window](image)

   Click Help for more information about the panel you are viewing.

   2. Click OK when you've finished reading the Help message.

   You return to the active panel.

   ✴ By the way: You can also get help while using the Option Panel by pressing the help key (F1). ✴

   If you still need help after using the Help button, see the "Troubleshooting" appendix for more suggestions.
Saving, printing, and displaying Apple IIe screens

Sometimes you may wish to have a “snapshot” of something that’s on your Apple IIe screen. You might want to save an image to use in a Macintosh program, to illustrate an instructional manual you are writing, or to show someone a problem you’re having with an Apple II program.

The Option Panel has several commands in the File and Edit menus that allow you take snapshots of your Apple II screens, as explained in the next three sections.

Saving a picture of an Apple IIe screen

To save a snapshot of what’s currently on your Apple IIe screen, follow these steps:

1. Open the Option Panel by pressing Control-⌘-Esc.
2. Choose the Save IIe Screen command from the File menu.
3. Type a name for the file.
   You can also use the usual ways to specify which disk and folder the file should be saved in.
4. Click Save.
   The file is saved on your disk. The files can be opened by any program that can understand PICT files. Most Macintosh drawing programs can understand PICT files. (Most painting programs cannot.)
5. Click Continue to return to your Apple IIe work, or click Quit IIe to return to the Macintosh environment.
Printing a picture of an Apple IIe screen

To print a snapshot of what's currently on your Apple IIe screen, follow the steps in this section.

**Before you begin**: If necessary, adjust the page settings as described in the next section, “Adjusting Page Setup for Printing Apple IIe Screens.”

1. Open the Option Panel by pressing Control-X-Esc.
2. Choose the Print IIe Screen command from the File menu.

   The print dialog box for your printer is displayed. Make any adjustments you like.

3. Click OK.
4. Click Continue to return to your Apple IIe work, or click Quit IIe to return to the Macintosh environment.

Adjusting Page Setup for printing Apple IIe screens

The Apple IIe screen is too wide to print the usual way on most printers. However, if your printer can print sideways (all Apple printers can), you won't have any problem. Follow these steps:

1. Choose the Page Setup command from the File menu.

   The Page Setup dialog box opens, as shown in the next step.
2. Click the sideways orientation icon.

3. Click OK.

Your screen snapshots should now fit on a page.

⹤ Have a LaserWriter? If you have an Apple LaserWriter, you can fit the image on a single sheet without printing sideways. Choose Page Setup from the File menu and click the Options button to display more printing options. Then click the Larger Print Area checkbox until an X appears and click the OK button in each of the two dialog boxes. ⹥
Copying a picture of an Apple IIe screen

To copy a snapshot of what's currently on your Apple IIe screen to the Clipboard, follow these steps:

1. **Open the Option Panel by pressing Control-⌘-Esc.**

2. **Choose the Copy IIe Screen command from the Edit menu.**
   The snapshot is placed on your clipboard. You can now paste the picture into any Macintosh program that understands PICT files.

3. **Click Continue to return to your Apple IIe work, or click Quit IIe to return to the Macintosh environment.**
Displaying a picture of an Apple IIe screen

To see your Apple IIe screen without leaving the Option Panel, follow these steps:

Before you begin: Make sure the Option Panel is open.

1. Choose the Show IIe Screen command from the File menu.

   A miniature version of the Apple IIe screen is displayed in a small window.

2. When you're finished viewing the picture, click the close its box.

   The window closes.

Formatting ProDOS floppy disks

Apple IIe programs can read files from 3.5-inch floppy disks only if they are formatted as ProDOS disks. The usual Macintosh way of formatting floppy disks cannot format ProDOS disks. Instead, you must use the Apple IIe way, using the System Utilities disk. See the instructions that came with the System Utilities disk for details.
Troubleshooting

If you have problems running Apple IIe programs on your Macintosh LC, look in this appendix for a description of your problem. You will find more than one suggested solution for the problems outlined in this appendix. Try each solution one at a time until the problem is solved.

If you don't find an answer to your problem here, contact your authorized Apple dealer.

Problems with Apple IIe files and disks

I can't see the Apple IIe partition I created on my hard disk

- If you're a floppy disk startup person, make sure you started up from the IIe Startup Disk.
- If you're a hard disk startup person, make sure that you still have the ProDOS File System document in your System Folder. (It should have been installed automatically when you followed the instructions in Chapter 2.)
I get a message saying no file servers were found

- If you want to start up from a file server, make sure you’re properly connected to the network.
- If you don’t want to start up from a file server, make sure you’ve correctly selected your startup device in the Slot Configuration panel. If AppleShare is in slot 7, the startup device should not be set to Scan.

The Macintosh says my ProDOS floppy disk is unreadable

- If you’re a floppy disk startup person, make sure you started up from the IIe Startup Disk.
- If you’re a hard disk startup person, make sure that you still have the ProDOS File System document in your System Folder. (It should have been installed automatically when you followed the instructions in Chapter 2.)
- Wait until you’re in the Apple IIe environment before inserting the disk.

Problems with IIe Startup

The settings I make in the Option Panel don’t take effect

- Make sure the settings you’ve made in the Option Panel apply to cards installed in active slots. If the cards are not in active slots, reassign them to active slots.
- Click the Restart IIe button to restart the Apple IIe Card. (Be sure to save your work on a floppy disk before restarting.)

The settings don’t work after I connect a new device

- Connecting a new device to your Apple IIe can cause all the Option Panel settings to change. Open the Option Panel and change them back again.
I can't set the Memory Expansion Card as large as I'd like

- If you're using MultiFinder, select the IIe Startup icon in the Macintosh environment, choose Get Info from the File menu, and check the application memory size for the IIe Startup program. The memory size for IIe Startup must be larger than the size you assign to the Memory Expansion Card in the Option Panel.

- If you're using MultiFinder, turn it off and restart the Macintosh LC. Restart the IIe Startup program; the program now has access to more of the computer’s memory.

The IIe Startup Disk complains that it can't create the IIe Prefs file

- If you started up from the IIe Startup Disk, make sure the disk is unlocked.
Problems starting up an Apple IIe program

I can't start up my Apple IIe program

- Make sure the disk you’re using is the correct program disk.
- Make sure the Apple IIe disk you want to start up from is an Apple IIe startup disk. The disk should contain the appropriate operating system files to allow the program to start. (See the manual that came with the program you want to run for more information.)
- Make sure you’ve set the startup slot correctly in the Slots portion of the Option Panel.
- Check the SmartPort portion of the Option Panel to make sure you have the disk drives in the correct slots.

I can’t start up my Apple IIe program by double-clicking its Macintosh icon

- If you’re a floppy disk startup person, make sure you started up your computer from the IIe Startup Disk.
- If you’re a hard disk startup person, make sure that you installed the Apple IIe Card software according to the instructions in Chapter 2.
- Make sure the Apple IIe program is either on a ProDOS floppy disk or on the Apple IIe partition of your hard disk.
- Try starting up the program from the Apple IIe environment instead.
My Apple IIe program won’t start up from the built-in 3.5-inch disk drive

- Make sure you’ve designated the built-in drive as the startup drive. Use the SmartPort panel and the “Changing the SmartPort Settings” section in Chapter 5 to confirm or change 3.5-inch drive configurations.

- Make sure you’ve set the SmartPort panel correctly so that the drive you’ve chosen as your startup drive is slot 5 drive 1.

- Make sure the Startup option in the Slot Configuration panel is set to Scan or to slot 5.

- Make sure the disk is not copy-protected. Some copy-protected program disks won’t work in a built-in drive. If the disk is copy-protected, try using it in an external UniDisk 3.5 Drive.

My Apple IIe program won’t start up from a UniDisk 3.5 Drive

- Make sure the disk drive is connected correctly to the Macintosh LC. (See Chapter 1 for instructions.)

- If you are using a UniDisk 3.5 Drive and an Apple 5.25 Drive, make sure the disk drives are correctly daisy-chained together, with the UniDisk 3.5 Drive first in the chain. (See Chapter 1 for instructions.)

- Make sure you’ve designated the UniDisk 3.5 Drive as the startup drive. Use the SmartPort panel and the “Changing the SmartPort Settings” section in Chapter 5 to confirm or change 3.5-inch drive configurations.

- Make sure you’ve set the SmartPort panel correctly so that the drive you’ve chosen as your startup drive is slot 5 drive 1.

- Make sure the Startup option in the Slot Configuration panel is set to Scan or to slot 5.
My Apple IIe program won’t start up from an Apple 5.25 Drive

- Make sure the disk drive is a gray Apple 5.25 Drive. (The earlier beige models are not compatible with the Apple IIe Card.)

- Make sure the disk drive is connected correctly to the Macintosh LC. (See Chapter 1 for instructions.)

- If you are using a UniDisk 3.5 Drive and an Apple 5.25 Drive, make sure the disk drives are correctly daisy-chained together, with the UniDisk 3.5 Drive first in the chain. (See Chapter 1 for instructions.)

- Make sure you’ve assigned the Apple 5.25 Drive to the correct location in the Slot Configuration panel—slot 6.

- Change the Speed setting in the General Controls panel to Normal. (Some copy-protection schemes prevent a program from running at the Fast setting.)

My Apple IIe program won’t work correctly

- If the program is on a hard disk, try running it from its original floppy disk instead.

- Consult the program’s manual for any required slot assignments, and then change the appropriate slot settings in the Option Panel to correspond to the required slot assignments. (Some programs require Apple IIe cards to be in specific slots and will not work if those cards are not installed in the appropriate slots).

- If the program runs correctly on an Apple IIe computer, but not on the Macintosh LC with an Apple IIe Card, make sure the Option Panel Slot Configuration settings are consistent with the slot assignments in the Apple IIe computer.

- Change the Speed setting to Slow in the General Controls panel.

- Change the Type Ahead setting to Off in the General Controls panel.
- Move the Clock Card to a Spare Card slot in the Slot Configuration panel.
- Move the Memory Card to a Spare Card slot in Slot Configuration panel.
- Move all other unnecessary cards to Spare Card slots in Slot Configuration panel.
- Some programs don't work well with both the joystick and the mouse installed. If you have a joystick connected, try disconnecting it.

My keyboard doesn't work properly
- Make sure the keyboard and mouse are correctly connected to the Apple Desktop Bus™ port on the back panel of the Macintosh LC. (See the instructions that came with your computer.) Make sure the computer is turned off before you connect or disconnect any cables.
- If you changed the keyboard and mouse configuration after starting the computer, turn off the computer and then restart it.
- Change the Type Ahead setting to Off in the General Controls panel. (Some programs are not compatible with the Type Ahead feature.)
I can't hear the beep

- Turn up the volume using the Macintosh Control Panel.

I can't control the volume of sounds my Apple IIe program makes

- You can control only the sound of the Apple IIe beep. There's no way to control the volume of other sounds.

My Apple IIe program runs too slowly

- Change the Speed setting to Fast in the General Controls panel.
- Change the Monitor setting to Black and White in the Macintosh Control Panel and the Display setting to Monochrome in the General Controls panel.
- Change the Key Repeat Rate in the General Controls panel to a faster setting.
- Change the Type Ahead setting to On in the General Controls panel.

My Apple IIe program runs too fast

- Change the Speed setting to Normal in the General Controls panel.
- If the program uses color graphics, make sure the monitor is set to color in the Macintosh Control Panel and that the Display option is set to color in the General Controls panel.
- Change the Key Repeat Rate in the General Controls panel to a slower setting.
- Change the Type Ahead setting to Off in the General Controls panel.
The text on my screen is unreadable

- If the text is readable when you run the program on an Apple IIe, but not on a Macintosh LC, adjust the Macintosh monitor’s brightness, contrast, and color (if you are using a color monitor).

- If the text is unreadable because of a color “fringe” around text characters, change the Display setting in the General Controls panel to monochrome.

My program won’t run in color

- Make sure you are using a color monitor.

- Make sure the Display option is set to color in the General Controls panel.

The mouse is difficult to control

- Adjust the sensitivity of the mouse in the Mouse panel.

- If the program offers other options for controlling the program, such as using the keyboard or a joystick, try them.

- If you have a joystick connected, try disconnecting it.

Problems with the Option Panel

The Option Panel opens unexpectedly

- Someone may have set a new keyboard shortcut for opening the Option Panel. Use the Additional Option Panel Key feature (in the General Controls portion of the Option Panel) to remove or change the key.
I can't see any of the controls or panels

- Someone may have locked the IlePrefs file. Use the Get Info command in the Macintosh Finder to unlock it.

- Someone may have installed special hardware for the Apple Ile Card to prevent tampering with the Option Panel. See an authorized Apple dealer to have it removed.

Problems with the modem

My Apple Ile program won't recognize my modem

- Make sure the modem is connected correctly to its power source and that the modem is turned on.

- Make sure the modem cable is connected to the correct port. The modem can be connected to either the modem or printer port, but make sure the panel for that port's Serial Card is set to Modem in the Option Panel.

- Make sure the Serial Card assigned to the port you are using is installed in an active slot—usually slot 1 for the Printer Port Super Serial Card, slot 2 for the Modem Port Super Serial Card.

- Make sure the AppleTalk option is turned off in the Macintosh Chooser if the modem is connected to the computer's printer port.

- Make sure the program's communication options are consistent with the slot settings in the Option Panel. (See the manual that came with the telecommunication program you want to run.)
My modem doesn't work properly at speeds greater than 1200 baud
- Select Monochrome in the General Controls portion of the Option Panel.

Problems with printing

I can't print a document
- Make sure the printer's power cord is plugged in and the printer's power switch is turned on.
- Make sure the printer cable is connected to the correct port.
- Make sure the AppleTalk option is turned off in the Macintosh Chooser if the printer is directly connected to the Macintosh LC (that is, if it is not connected via a network).
- Make sure the Printer Card is in a slot that your program can print to, usually slot 1 (and sometimes slot 7).
- Make sure the program's print options are consistent with the slot settings in the Option Panel. (See the manual that came with the program you want to run.)
- If you're printing through the Printer Card, make sure your Apple IIe program is set to print to an ImageWriter II. No matter what printer you're actually using, the Printer Card treats it like an ImageWriter II.
- Turn on the Extend Printer Timeout feature in the Printer Card portion of the Option Panel.
- Make sure you're using version 6.0.8 of Macintosh system software.

The pages don't break right or another document prints in the middle of mine
- Turn on the Extend Printer Timeout feature in the Printer Card portion of the Option Panel.
Problems ejecting disks

I can't eject the disk from the built-in disk drive

- Use the Eject buttons in the Option Panel, or press ⌘-Shift-1.
  (Press ⌘-Shift-2 to eject a disk from a second built-in disk drive.)

- The disk label may be sticking, or the disk may be in backward.
  Call your authorized Apple dealer to help fix these problems.

I can't eject the disk from an external disk drive

- If the drive is a UniDisk 3.5 Drive, make sure the drive is properly connected and that the Macintosh is turned on.
  Make sure the computer is turned off before you connect or disconnect any cables.

- If the drive is a UniDisk 3.5 Drive, press the Eject button on the drive. If the drive is an Apple 5.25 Drive, open the disk drive door.

- The disk label may be sticking, or the disk may be in backward.
  Call your authorized Apple dealer to help fix these problems.

Problems copying files to Apple IIe disks

I get the message “File couldn’t be written and was skipped.”

- Make sure that all the files you are copying have fewer than 15 characters in their names.
Using a Hard Disk

You can use your hard disk to store Apple IIe files and programs, but only if you create a ProDOS partition, as explained in “Reserving Hard Disk Space for Apple IIe Files” in Chapter 1.

This appendix explains how to use the partition once you’ve created it.

If you’ve partitioned your hard disk as described in Chapter 1, storing Apple IIe files on a hard disk is much like storing regular Macintosh files on a hard disk.

Here’s a rule to help you avoid trouble using your two parts of your hard disk: Store Macintosh files on the Macintosh partition and store Apple IIe files on the Apple IIe partition.

Technically, the Macintosh will let you store either sort of file on either sort of partition, but Apple IIe programs can’t see anything stored on a Macintosh partition and Macintosh programs may not work well if they’re stored on an Apple IIe partition.

In short, you’ll always be safe if you store Macintosh files on Macintosh partitions and Apple IIe files on Apple IIe partitions.
Where to put the software for the Apple IIe Card

The Apple IIe Card itself requires some software, which you installed in Chapter 2. That software, including the IIe Startup program, belongs on the Macintosh partition. You should also have a copy of BASIC.SYSTEM and PRODOS on the Apple IIe partition.

Manipulating Apple IIe files on the Macintosh desktop

You can copy, move, and throw away Apple IIe files just like other Macintosh files, but only when you start up from a disk that has the startup document ProDOS File System in the System Folder. (You learned how to install this file in “Installing the Software on Your Hard Disk” in Chapter 2.)

In fact, you can only see your Apple IIe files if the ProDOS File System icon is in the System Folder on your startup disk. If you are a floppy disk startup person, as explained in Chapter 2, you must start up from the IIe Startup Disk to see and manipulate Apple IIe files when in the Macintosh environment.

Which Apple IIe programs will work on a hard disk

Not every Apple IIe program works well on a hard disk. The best way to find out if a particular program works on your hard disk is to copy it (and all of its accompanying files) to a folder on your Apple IIe partition and try it.

Here's some guidelines about which programs work well and which don't work at all on a hard disk:

- If the manual for the program includes instructions for installing it on a hard disk, it will probably work well on your Apple IIe partition.
- If the program is copy-protected, it probably won't work on a hard disk.
- DOS 3.3 and Pascal programs will not run on a hard disk.
Creating Custom Partitions

The section “Reserving Hard Disk Space for Apple IIe Files” in Chapter 1 explains the easiest way to partition hard disks to store Apple IIe files. However, that way creates a 10 MB Apple IIe partition. If you need a larger or smaller partition, use the Custom feature of Apple HD SC Setup, explained in this appendix.

Preparations

Before you can create a custom partition, you must back up your hard disk and then start up the program called Apple HD SC Setup, as follows:

1. Back up your hard disk, as described in “Backing Up Your Hard Disk” in Chapter 1.
2. Turn off your Macintosh.
3. Insert the IIe Installer Disk.
4. Turn on the Macintosh.
5. Open the IIe Installer Disk.
6. Double-click the Apple HD SC Setup icon.

7. Click the Drive button until you see the name of the hard disk you want to partition.

8. Click Update.

9. Click the Partition button.

You're now prepared to create the custom partition.

The custom partition

You should now be looking at the partitioning window in Apple HD SC Setup. To create a custom Apple IIe partition, follow these steps:

1. Click Custom.

2. Select the main partition.

3. Click Remove, and when asked for confirmation, click OK.
4. Create a new partition by dragging, as shown in the figure.

5. Click “Macintosh Volume.”

6. Type a number to indicate the size you want your Macintosh partition to be.

   For example, if you wanted to split a 40 MB hard disk into two equal partitions, you would type 20000

7. Click OK.
8. Create a second new partition by dragging.

9. Click “ProDOS Volume,” then click OK.

10. When prompted, type a name for the partition.

   ProDOS names can contain only numbers and letters. If you want to create a second ProDOS partition, repeat steps 8 through 10.

   You can have up to two separate ProDOS partitions. You must always have at least one Macintosh partition. (If you don’t have a Macintosh partition, you won’t be able to see the hard disk’s icon when you’re in the Macintosh environment.)

11. Click Done.

12. Click Quit.

   You’re now ready to restore your files as described in “Restoring the Contents of Your Hard Disk” in Chapter 1.
Parts of the Apple IIe Card Software

Whether you’re a hard disk startup person or a floppy disk startup person, your Apple IIe Card software is made up of the five files shown in this appendix.
The program that starts up the Apple IIe environment

The file that stores the choices you make in the Option Panel. (The IIe Prefs file is created the first time you run the IIe Startup program.)

The two files that allow you to start up Apple IIe programs by double-clicking their icons

The file that you must have in your System Folder in order to see Apple IIe files and disks on your Macintosh desktop

Appendix D: Parts of the Apple IIe Card Software
Installing Printer Software for the *IIe Startup Disk*

*If you are a floppy disk startup person, you must have the correct printer software installed on the *IIe Startup Disk*. The disk has the software for many Apple printers already installed. If your printer’s software is not on the disk, you need to install it according to the instructions in this appendix.*
Is your printer’s software already installed?

The *Ile Startup Disk* comes with software for the following printers:

- ImageWriter II (with or without AppleTalk)
- All LaserWriter and LaserWriter II printers (except the LaserWriter SC and the Personal LaserWriter printers)

If you have any of these printers, you *do not* have to continue with this appendix. If your printer is not in this list, continue with the next section.

Printers connected to original Apple Ile computers

This section explains the details associated with using printers that have previously been connected to an Apple Ile computer. If your printer was purchased specifically for use with a Macintosh, skip this section and go to “Installing Software for Your Printer.”

Some printers connected to your original Apple Ile can readily be connected to your Macintosh LC, while others cannot:

- **Apple printers.** If you have an ImageWriter printer or other printer manufactured by Apple, it can be connected to your Macintosh in the standard way. Go now to “Installing Software for Your Printer.”

- **Other printers.** Other printers require special attention. Apple does not recommend using these printers, but if you do, take into account the following three points: (1) you can only use the printer when you're in the Apple Ile environment; (2) you must have a special cable made so you can plug the printer into either the modem port or the serial port on the back of your Macintosh; and (3) to use the printer in the Apple Ile environment, you must print through one of the Serial Cards instead of the Printer Card.
This appendix pertains only to printers designed for use with the Macintosh, so if the only printer you're connecting is an Apple IIe printer manufactured by a company other than Apple, you should skip the rest of this appendix.

Installing the software for your printer

To install the software for your printer, you must first make room on the IIe Startup Disk and then follow the software installation instructions that came with your printer, as described in these steps:

Before you begin: Turn your Macintosh LC off.

1. Insert the IIe Startup Disk.
2. Turn on your Macintosh.
3. Open the IIe Startup Disk by double-clicking its icon.
4. Open the System Folder by double-clicking its icon.

You may have to use the scroll bars to see the System Folder.

5. Drag the following four icons to the Trash.

![LaserWriter](image1.png) ![Laser Prep](image2.png) ![AppleTalk](image3.png) ![ImageWriter](image4.png) ![ImageWriter](image5.png)

These icons represent the software for several printers. By throwing them away, you'll make room for your printer software.

If you have a LaserWriter or an ImageWriter connected to your Macintosh, you can leave the appropriate icon or icons on the disk.
6. See the instructions that came with your printer to install the software.

Some manuals might call this "installing the print driver." Usually it involves dragging one or two icons from the disk supplied with the printer into the System Folder. Many Apple printers use the Installer program to do the copying.

⚠️ Important: Remember, you are installing the software on the *Ile Startup Disk*, not on your hard disk (if you have one). ⚠️

7. When you’re finished, select the printer in the Chooser, as described in “Setting Up the Printer Software” in Chapter 2.
System 7 and the Apple Ile Card

Apple does not recommend using the Apple Ile Card with System 7. In fact, the Apple Ile Card was tested only with version 6.0.8 of Macintosh system software. However, some people may wish to experiment with System 7.

Here’s some advice for the adventurous:

- Your computer should have at least 4 MB of random-access memory (RAM).
- If an Apple Ile program doesn’t seem to work when you’re using System 7, try it with the Ile Startup Disk to see if it works with version 6.0.8 of system software.
- The Apple Ile Card doesn’t always work well with personal file sharing, so turn off file sharing when using the Apple Ile Card.
- Whenever you use untested combinations of software, including System 7 and the Apple Ile Card software, take extra care with your data. Be especially conscientious about making backups.
- The Apple Ile Card will not work with 32-bit addressing. Turn off 32-bit addressing in the Memory portion of the Macintosh Control Panel.
accessory card A card that, when installed in the computer, lets you perform specialized functions not built into the computer. The Apple Ile Card is an accessory card.

Apple HD SC Setup A Macintosh program that formats hard disks. See also partitioning.

Apple Ile Card An accessory card that you use to run Apple Ile programs on a Macintosh LC computer.

Apple Ile environment The environment established when you run the Ile Startup program. When you are in the Apple Ile environment, your Macintosh LC performs as if it were an Apple Ile.

Apple Ile Option Panel An important feature of Ile Startup that you use to personalize your Apple Ile work environment, configure slot settings, and navigate through the Apple Ile environment. To open the Option Panel, you press Control-#-Esc.

BASIC programming language A programming language built into Apple II computers. The BASIC programming language is also built into the Apple Ile Card.

BASIC prompt A square bracket that appears on the screen when you are in the BASIC programming environment. It indicates the location of the next instruction you type.

cards See accessory card.

Character Set setting A setting in the General Controls panel that you use to choose between normal text (light characters on a dark background) and inverse text (dark characters on a light background).
**key**  The Command key. A key on the bottom row of the Macintosh keyboard that, when held down while another key is pressed, causes a command to take effect. The $key is equivalent to the Open Apple key on Apple IIe keyboards.

**Shift-1**  A combination keystroke that ejects any disk from the built-in floppy disk drive. With Macintosh computers that have two built-in disk drives, Shift-1 ejects any disk from the first built-in drive.

**Shift-2**  A combination keystroke that ejects any disk from the second built-in floppy disk drive, on Macintosh computers that have two built-in drives.

**Continue button**  A button in the lower portion of the Apple IIe Option Panel. You click it to return to what you were doing prior to opening the Option Panel.

**Control Panel**  See Macintosh Control Panel.

**Control-:Esc**  A combination keystroke that opens the Apple IIe Option Panel. Press Control-:Esc whenever you need to use the Option Panel.

**D**

daisy-chain  To link together sequentially.

**Delay Until Key Repeat setting**  A setting in the General Controls panel. You use it to set the length of the delay before a character begins repeating when its key is held down. See Key Repeat rate.

**desktop**  See Macintosh desktop.

**Display setting**  A setting in the General Controls panel that you use to choose between a monochrome and color display. (The Color setting works only if you have a color monitor.)

**E**

**Eject buttons**  Two buttons in the lower portion of the Apple IIe Option Panel that you use to eject disks from the built-in floppy disk drive or drives. If your computer has two built-in drives, both buttons are active. If your computer has only one built-in drive, only the rightmost button is active; the inactive button appears dimmed.

**environment**  A particular manner or method in which the computer functions. The Apple IIe Card allows the Macintosh LC to have an Apple IIe environment—that is, to act in a manner that conforms to Apple IIe conventions.

**F**

**Finder**  See Macintosh Finder.

**floppy disk startup people**  People who must start up from the Ile Startup Disk to use the Apple IIe Card, generally because they do not have a hard disk or because the hard disk contains a version of system software incompatible with the Apple IIe Card. Compare hard disk startup people.

**G**

**General Controls panel**  A panel in the Apple IIe Option Panel that you use to set preferences for personalizing your Apple IIe work environment. The General Controls panel appears whenever you open the Apple IIe Option Panel.
H, I, J

Hard disk startup people People who can use the Apple IIe Card without restarting from a special floppy disk. Hard disk startup people install the Apple IIe Card software directly on their hard disk. Compare floppy disk startup people.

Help button A button in the lower portion of the Apple IIe Option Panel that, when clicked, presents a Help window that explains the current panel.

Help window A window that appears when you click the Help button in the Apple IIe Option Panel. The Help window explains the current panel.

K, L

Key Repeat rate A setting in the General Controls panel. You use it to adjust the rate at which a character appears repeatedly on the screen while you hold down its key. See Delay Until Repeat setting.

M, N

Macintosh Control Panel A Macintosh desk accessory that you use to personalize your Macintosh work environment.

Macintosh desktop The Macintosh working environment—the menu bar and the gray area on the screen.

Macintosh Finder The Macintosh program that maintains the Macintosh desktop. You use the Finder to start up other programs, manage documents and programs, and move information to and from disks.

Memory Expansion Card panel A panel in the Apple IIe Option Panel. You use it to add additional memory by designating a portion of the Macintosh LC computer’s available memory for Apple IIe programs. Apple IIe programs interpret this extra memory as an Apple II Memory Expansion Card.

Modem Port Serial Card panel A panel in the Apple IIe Option Panel that you use to configure the Macintosh LC modem port as if it were a Super Serial Card installed in an Apple IIe.

Mouse Card panel A panel in the Apple IIe Option Panel that you use to adjust the mouse tracking rate (the speed at which the pointer responds to your movement of the mouse).

Mouse Tracking rate A setting in the Mouse Card panel. You use it to adjust the rate at which the pointer responds to your movement of the mouse.

O

Option key A key on the Macintosh keyboard that gives an alternate interpretation to another key you press. You use it to type international characters or special symbols. The Option key is equivalent to the ⌘ (Solid Apple) key on the Apple IIe keyboard.

Option Panel See Apple IIe Option Panel.

P

Partitioning Preparing a hard disk so it can store certain sorts of files. You can use the Macintosh program Apple HD SC Setup to partition your hard disk so it can store Apple IIe files.
prefs file  See Ille Prefs.

Printer Card  A software representation of an Apple Ille Card you need to install in the
Slots Configuration panel if you want to print. The Printer Card generally goes in slot 1.

Printer Port Serial Card panel  A panel in the Apple Ille Option Panel that you use to
configure the Macintosh LC printer port as if it were a Super Serial Card installed in an
Apple Ille.

printer timeout  An error that can stop printing if a printer takes too long to finish. You can extend
the amount of time your printer can take before causing a printer timeout error by clicking the
Extend Printer Timeout box in the Printer Card panel.

ProDOS  An Apple Ille operating system used by many Apple Ille programs.

ProDOS File System  A startup document that allows you to see Apple Ille files and disks on
your Macintosh desktop. The ProDOS File System document goes in your System Folder.

Q

Quit Ille button  A button in the lower portion of the Apple Ille Option Panel that you click to
quit the Apple Ille environment.

R

Read Me document  A document included on a program disk to provide you with late-breaking
information about the program or product. You will find a Read Me document on the
Ille Startup Disk.

Reset key  A key in the upper portion of the Macintosh keyboard identified by a triangular
icon. In the Apple Ille environment, the Reset key is used in exactly the same manner as the
Reset key on an Apple Ille keyboard.

Restart Ille button  A button in the lower portion of the Apple Ille Option Panel. You click it to reset
the Apple Ille Card and restart Ille Startup.

S

Slot Configuration panel  A panel in the Apple Ille Option Panel that you use to configure the
Apple Ille slot settings for the Apple Ille programs you run on the Macintosh LC.
The slot settings you choose in the Slot Configuration panel are software representations
of the actual Apple Ille slots and cards.

slots  The receptacles inside an Apple Ille computer that accept accessory, peripheral, and controller
cards that allow the computer to operate. The Ille Startup program uses software
representations in place of the actual Apple Ille slots and cards.

SmartPort panel  A panel in the Apple Ille Option Panel that lets you increase by two the number
of drives accessible to Apple Ille programs. You use the SmartPorts panel to designate a startup
drive among the 3.5-inch floppy disk drives included in your computer system.

Speed setting  A setting in the Apple Ille Option Panel that you use to set the processing speed of
the Apple Ille Card. You use this setting to slow down or speed up Apple Ille programs running
on the Macintosh LC. Two settings are available: Normal and Fast.
Startup Beep setting  A setting in the Apple IIe Option Panel that you use to choose a startup beep sound. The startup beep sound is also used by many programs as an alert sound.

T, U, V, W, X, Y, Z

IIe Prefs  A file created automatically the first time you run IIe Startup. The IIe Prefs file maintains the settings in the Apple IIe Option Panel. Any changes you make in the Option Panel are automatically saved in the IIe Prefs file when you quit the IIe Startup program.

IIe Startup  The program that you use to run Apple IIe programs with the Apple IIe Card. The IIe Startup program starts up the Apple IIe Card, controls the Apple IIe work environment according to your settings in the Apple IIe Option Panel, and provides a means of navigating within the Apple IIe environment.

Type Ahead setting  A setting in the Apple IIe Option Panel that you use to turn on and off Type Ahead, an option that lets you type text or commands while the computer is busy performing a task.
A
accessory cards. See cards, in Option Panel
Additional Option Panel Key setting, in
Option Panel 96
Apple 5.25 Drive
configuring for startup 109–111
connecting 12–14
daisy-chaining 17–19
ejecting disks from 114–115
problems with 142
startup problems 134–135
Apple HD SC Setup icon 7
Apple HD SC Setup program 6–9, 145–148
AppleShare Card icon, in Option Panel 84
AppleTalk
modem problems and 140
printer problems and 141
Apple IIe Card. See also Apple IIe environment
installing xiv
installing software for 25–36
on a floppy disk 33–35
on a hard disk 29–33, 144
restarting 120–121
using 37–58
with MultiFinder 123–124
with System 7 155–156
Apple IIe devices, connecting 20–22
Apple IIe disk drives
configuring for startup 109–111
connecting 12–19, 23–24
daisy-chaining 17–19
startup problems 134–135
Apple IIe environment
changing startup device for 109–111
closing Option Panel 118–119
configuring for. See configuring cards and slots
customizing. See customizing
getting help 125
moving back to Macintosh desktop from 42–43,
122
opening Option Panel 96, 116
quitting 122–123
restarting Apple IIe Card 120–121
switching to 40–41
Apple IIe files
   copying 57
   deciding where to store 2–4
   discarding 57, 58
   legal ProDOS names for 9
   managing 56–58
   manipulating 144
   naming 9, 58
   on a file server 84
   problems with 131–132
   storing on a hard disk 143
   using Macintosh programs with 81–82
Apple IIe Option Panel. See Option Panel
Apple IIe partition icon 9
Apple IIe pictures, copying to a Macintosh program 82–83
Apple IIe port 13, 15, 21
Apple IIe programs
   configuring startup slot for 109–111
   Memory Card for 99–102
   printing from 79
   problems with 134–139
   running 43–47, 76–79
      from a hard disk 144
      in the Apple IIe environment 46–47, 78–79
      in the Macintosh environment 43–45, 77
Apple IIe screens, pictures of
   copying 129
   displaying 130
   printing 127–128
   saving 126
Apple user group, finding nearest xvi
B
   backing up a hard disk 5
   BASIC prompt 74, 79
      starting up a program disk from 79
   BASIC.SYSTEM icon 32, 150
   baud. See modems
   beep sound
      choosing 87–89
      problems with 138
   Berkeley Macintosh Users’ Group xvi
   black-and-white monitor
      changing setting for 93–94
      flashing text on 95
      problems with 139
   Boston Computer Society xvi
   buttons, Option Panel
      Continue 118
      Eject 115
      Help 125
      Quit IIe 122
      Restart IIe 121
C
   cables 13–22
   cards, in Option Panel 68. See also configuring cards
      and slots; customizing; Option Panel
   Apple IIe names 62
      uses for 64
   character set, changing display of 95
   Clock Card icon, in Option Panel 68
   color monitor
      changing setting for 93–94
      flashing text on 95
      problems with 139
Color setting, in Option Panel 93–94
Command (⌘) key xv
configuring cards and slots 59–70, 99–114.
  See also cards, in Option Panel; customizing
Memory Card 99–102
Printer Card 105–107
Serial Cards 102–105
slot settings 107–109
SmartPort settings 112–114
startup device 109–111
Super Serial Cards 102–105
connecting
Apple 5.25 Drive 12–14, 17–19
Apple Ile hard disks 23–24
file servers 66
hand controls 20–22
joysticks 20–22
modems 66–67, 102–105
multiple disk drives 17–19
other devices 20–22
serial devices 66–67, 102–105
UniDisk 3.5 Drive 15–19
Continue button, in Option Panel 118
Control Panel, Macintosh
  beep sound and 89, 138
  Color/Monochrome settings and 93
  mouse tracking rate and 97
copying
  Apple Ile files 57
  Apple Ile pictures, to a Macintosh program 82–83
  Apple Ile screens, pictures of 129
  crashes, system 11
  customizing 85–99. See also configuring cards and slots
  display (color vs. monochrome) 93
  display of text 95
  key repeat delay 90–91
  key repeat rate 89–90
  mouse tracking rate 97–98
  processing speed 85–87
  startup beep sound 87–89
  Type Ahead feature 92–93

D
daisy-chaining disk drives 17–19
Delay Until Key Repeat setting, in Option Panel 90–91
deleting files 57, 58
desktop. See Macintosh desktop
devices, connecting other 20–22
discarding files 57, 58
disk drives, floppy. See also disks, hard
  compatible with the Macintosh LC 12
  configuring for startup 109–111
  connecting 12–19
    Apple 5.25 Drive 12–14
    multiple 17–19
    UniDisk 3.5 Drive 15–16
daisy-chaining 17–19
startup problems 134–135
swapping 14
disks, floppy
  displaying contents of 57
duplicating files in 57
ejecting 114–115
  keyboard shortcuts 115
  problems with 142
formatting as ProDOS disks 130
installing Apple IIe Card software on 33–35
locking 2
opening icon 57
problems with 132, 134–136
IIe Installer Disk 30
IIe Startup Disk 33
starting up from 38–39
disks, hard. See also disk drives, floppy
  backing up 5
  connecting 23–24
  installing Apple IIe Card software on 29–33, 144
partitioning 4–11, 145–148
problems with 131, 134
restoring contents of 10–11
running Apple IIe programs from 144
using 143–144
  as startup device 27–33
drawing
  mouse tracking rate for 97–98
  problems with 139
duplicating files 57

F
files. See also Apple IIe files; icons; IIe Prefs file
discarding 57, 58
duplicating 57
managing 56–58
file servers
  problems with 132
  slot configuration for 66
  starting up from 83–84
  using files on 84
Finder, checking memory in 99–100
5.25 Drive icon, in Option Panel 68
flashing text, appearance of 95
floppy disk drives. See disk drives, floppy
floppy disks. See disks, floppy
floppy disk startup person 33

G
General Controls panel, in Option Panel 85
  buttons in
    Continue 118
    Eject 115
    Help 125
    Quit IIe 122
    Restart IIe 121
display of text 95
flashing text, appearance of 95
settings in
  Additional Option Panel Key 96
    Color 93–94
    Delay Until Key Repeat 90–91
    Inverse Text 95
    Key Repeat Rate 89–90
    Monochrome 93–94
    Normal Text 95
    Speed 85–87
    Startup Beep Sound 87–89, 138
    Type Ahead 92–93
General icon, in Option Panel 86
graphics
  mouse tracking rate for 97–98
  problems with 139

H
hand controls, connecting 20–22
hard disks. See disks, hard
hard disk startup person 30
Help button, in Option Panel 125

I
icons. See also files
Apple HD SC Setup 7
Apple IIe partition 9
BASIC.SYSTEM 32, 150
in Option Panel 68
  AppleShare Card 84
  Clock Card 68
  5.25 Drive 68
  General 86
  Memory Card 101
  Monitor Card 68
  Mouse Card 98
  Printer Card 106
  Serial Card 103
  Slots 108
  SmartPort 113
Installer icon 30
installing
  Apple IIe Card xiv
  Apple IIe Card software 25–36
    on a floppy disk 33–35
    on a hard disk 29–33, 144
  printer software 151–154
  interference, radio and television ix
Inverse Text setting, in Option Panel 95

J
joysticks, connecting 20–22

K
keyboard
  keys, defined xv, 120
  problems with 137
  repeat delay rate, setting 90–91
  repeat rate, setting 89–90
  typing ahead 92–93
keyboard shortcuts
  ejecting disks 115
  getting help 125
  opening Option Panel 96, 116
  quitting Apple IIe environment 122–123
  restarting Apple IIe Card 120
Key Repeat Rate setting, in Option Panel 89–90

L
locking floppy disks 2

M
Macintosh Control Panel
  beep sound and 89, 138
  Color/Monochrome settings and 93
  mouse tracking rate and 97
Macintosh desktop, moving back to 42–43, 122
Macintosh Finder, checking memory in 99–100
Macintosh LC computer, connecting Apple IIe devices to 12–24
Macintosh MultiFinder
  Memory Expansion Card size and 133
  using Apple IIe Card with 123–124
Macintosh programs
  copying Apple IIe pictures to 82–83
  using Apple IIe files with 81–82
memory capacity, increasing 99–102
  problems with 133
Memory Card, configuring 99–102
Memory Card icon, in Option Panel 101
Memory Expansion Card panel, in Option Panel 99–102
messages. See troubleshooting
modem port, on Macintosh LC computer 102
modems
  connecting 66–67, 102–105
  problems with 140–141
  slot configuration for 66–67
  using at speeds higher than 1200 baud 105
monitor. See color monitor; monochrome monitor
Monitor Card icon, in Option Panel 68
monochrome monitor
  changing setting for 93–94
  flashing text on 95
  problems with 139
Monochrome setting, in Option Panel 93–94
Mouse Card icon, in Option Panel 98
Mouse Card panel, in Option Panel 97–98
mouse tracking rate, changing 97–98
MultiFinder
  Memory Expansion Card size and 133
  using Apple IIe Card with 123–124
N
naming Apple IIe files 58
network file servers. See file servers
network, slot configuration for 66
Normal Text setting, in Option Panel 95
O
Open Apple (⌘) key xv
Option key xv
Option Panel 48–56
  buttons in
    Continue 118
    Eject 115
    Help 125
    Quit IIe 122
    Restart IIe 121
cards in 68
  Apple IIe names 62
  uses for 64
closing 118–119
icons in
  AppleShare Card 84
  Clock Card 68
  5.25 Drive 68
  General 86
  Memory Card 101
  Monitor Card 68
  Mouse Card 98
  Printer Card 106
  Serial Card 103
  Slots 108
  SmartPort 113
  limiting access to 116–117
  mouse tracking rate 97–98
  opening 96, 116
    when IIe Startup program launches 74
Option Panel (continued)

panels in
  General Controls 85
  Memory Expansion Card 99–102
  Mouse Card 97–98
  Slot Configuration 53–56, 107–109
problems with 132–133, 139–140
returning to work from 118–119
setting up cards and slots in 59–70
settings in
  Additional Option Panel
    Key 96
    Color 93–94
    Delay Until Key Repeat 90–91
    Extend Printer Timeout 106
    Inverse Text 95
    Key Repeat Rate 89–90
    Monochrome 93–94
    Normal Text 95
    Speed 85–87
    Startup Beep Sound 87–89, 138
    Type Ahead 92–93
  Ile Startup problems 132–133

P

partition, hard disk
  creating 4–11, 145–148
  problems with 131
  using 143–144
performance
  Color/Monochrome settings and 93
  5.25 Drives and 111
  problems with 138
  Speed setting and 85–87
personalizing. See customizing; configuring
pictures, Apple Ile, copying to a Macintosh program 82–83

pointer
  mouse tracking rate and 97–98
  problems with 139
ports, on Macintosh LC computer
  Apple Ile 13, 15, 21
  modem 102
  printer 102
preferences file. See IIe Prefs file
Printer Card icon, in Option Panel 106
printer, choosing in the Chooser 79–80
printer icons, in Macintosh Chooser 80
printer port, on Macintosh LC computer 102
printer software, installing 151–154
printer timeout, setting 105–107
printing
  from Apple Ile programs 79
  Apple Ile screens, pictures of 127–128
  configuring for 102–107
  troubleshooting 141
problems. See troubleshooting
processing speed. See performance
ProDOS disks
  formatting 130
  problems with 132
ProDOS File System icon 150
PRODOS icon 32, 150
ProDOS names, legal 9
ProDOS, SmartPort devices and 112–114
programs. See Apple Ile programs; icons; Ile Startup program

Q

Quit Ile button, in Option Panel 122
radio interference  ix
Read Me icon  26
rebuilding the system  11
repeat delay rate, setting for keyboard  90–91
repeat rate, setting for keyboard  89–90
Reset key, defined  47
restarting Apple IIe Card  120–121
Restart IIe button, in Option Panel  121
restoring the contents of a hard disk  10–11
running
  Apple IIe programs  43–47, 76–79
  from a hard disk  144
  in the Apple IIe environment  46–47, 78–79
  in the Macintosh environment  43–45, 77
  problems with  134–139
IIe Startup program  72–75
  problems with  132–133

screen display
  color vs. monochrome  93–94
  flashing text on  95
  problems with  139
screens, pictures of Apple IIe
  copying  129
  displaying  130
  printing  127–128
  saving  126
Serial Card icons, in Option Panel  103
Serial Cards, configuring  102–105
serial devices, connecting  66–67, 102–105
servers. See file servers
setup. See installing; partition, hard disk
Slot configuration panel, in Option Panel  53–56, 107–109
slots. See configuring cards and slots
Slots icon, in Option Panel  108
SmartPort drive and slot assignments, changing  112–114
SmartPort icon, in Option Panel  113
starting up
  Apple IIe programs  43–47, 76–79
  from a hard disk  144
  in the Apple IIe environment  46–47, 78–79
  in the Macintosh environment  43–45, 77
  problems with  134–136
  from a file server  83–84
  from IIe Startup Disk  38–39
IIe Startup program  72–75
  problems with  132–133
Startup Beep Sound setting, in Option Panel  87–89
  problems with  138
startup device
  changing  109–111
  using hard disk as  27–33
Startup pop-up menu  110
startup program. See IIe Startup program
Super Serial Cards, configuring  102–105
swapping
  floppy disk drives  14
  other devices  22
SYSTEM, at the end of icon names  77
system crashes  11
system, rebuilding  11
System 7, and Apple IIe Card  155–156
system software version
  checking  27–28
  required  3

software. See also Apple IIe programs; IIe Startup
  program
  Apple IIe Card, installing  25–36
    on a floppy disk  33–35
    on a hard disk  29–33, 144
  printer, installing  151–154
system
  checking version  27–28
  required version  3
System 7, and Apple IIe Card  155–156
Solid Apple ( Ⓢ ) key  xv
speed. See performance
Speed setting, in Option Panel  85–87

Index
T

Television interference ix

Text, changing display 95

Tracking rate (mouse), changing 97–98

Troubleshooting 131–142

Apple IIe partition 11, 131

Apple IIe programs

Running 136–139

Starting 134–136

Beep sound 89, 138

Card, not installed 70

Disks, Apple IIe

Ejecting 142

Recognizing 39, 132

Files

Copying 142

Seeing 82

File server 132

Floppy disk drives compatible with the

Macintosh LC 12

Keyboard 92–93, 137

Memory Expansion Card size

Messages

“File couldn’t be written and was skipped” 142

“UNABLE TO BOOT FROM STARTUP SLOT” 74, 78

Modem 105, 140–141

Option Panel 132–133, 139–140

Printing 80, 141

Processing speed 138

Screen display 139

Sound volume 138

System crashes 11

IIe Prefs file, creating 133

IIe Startup 132–133

IIe files. See Apple IIe files

IIe Installer Disk 30

IIe Prefs file 75, 150

Limiting access to Option Panel 116–117

Problems creating 133

Using more than one 75–76

IIe Prefs icon 75, 150

IIe Startup Disk 33

Installing printer software for 151–154

Starting up from 38–39

IIe Startup icon 32, 150

IIe Startup program 72–75

Problems with 132–133

TypeAhead setting, in Option Panel 92–93

U, V

UniDisk 3.5 Drive

Configuring for startup 109–111

Connecting 15–16

Daisy-chaining 17–19

Ejecting disks from 114–115

Problems with 142

Startup problems 135

User groups xvi

W, X

Work environment, customizing. See customizing

Y, Z

Y-shaped cable 13–22
Startup Method

How you install the Apple IIe Card software determines how you start up the Macintosh. Check the box that describes how you installed the software. (The installation instructions are in Chapter 2 of the *Apple IIe Card Owner's Guide.*)

- **Floppy Disk Startup**
  1. Turn off the Macintosh LC.
  2. Insert your copy of the IIe Startup Disk.
  3. Turn on the Macintosh LC.
  4. Find and double-click the IIe Startup icon.

- **Hard Disk Startup**
  1. Turn on the Macintosh LC.
  2. Find and double-click the IIe Startup icon.

Opening the Option Panel

To make certain changes to your Apple IIe environment or to return to the Macintosh environment, you must open the Option Panel.

When you're in the Apple IIe environment, you open the Option Panel by pressing these three keys at the same time:

![ctrl shift esc keys](image)

Resetting the Apple IIe Card

To perform a "cold reset" of your Apple IIe, press these three keys at the same time:

![ctrl shift esc keys](image)

(If you press these keys while in the Option Panel, you will reset the Macintosh, not the Apple IIe Card.)
## Option Panel Cards

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Replaces old Apple Ile Accessory Card</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="5.25-inch Drive Card Icon" /></td>
<td>5.25-inch Drive Card</td>
<td>Apple 5.25 Drive Interface Card</td>
<td>Only needs to be installed if you have a 5.25-inch disk drive connected to your Macintosh LC.</td>
</tr>
<tr>
<td><img src="image" alt="AppleShare Card Icon" /></td>
<td>AppleShare Card</td>
<td>Apple Ile Workstation Card</td>
<td>Only needs to be installed if you are connected to a file server. Then it's usually installed in slot 7.</td>
</tr>
<tr>
<td><img src="image" alt="Clock Card Icon" /></td>
<td>Clock Card</td>
<td>Any clock card</td>
<td>Only needs to be installed if you have Apple Ile programs that use a clock card.</td>
</tr>
<tr>
<td><img src="image" alt="Memory Card Icon" /></td>
<td>Memory Card</td>
<td>Apple Ile Memory Expansion Card</td>
<td>Used to increase the amount of memory available for your Apple Ile programs.</td>
</tr>
<tr>
<td><img src="image" alt="Monitor Card Icon" /></td>
<td>Monitor Card</td>
<td>Any Apple Ile monitor card</td>
<td>Cannot be moved from slot 3. You control the monitor settings in the Apple Ile Option Panel and the Macintosh Control Panel.</td>
</tr>
<tr>
<td><img src="image" alt="Mouse Card Icon" /></td>
<td>Mouse Card</td>
<td>Apple Ile Mouse Card</td>
<td>Only needs to be installed if you have Apple Ile programs that can use a mouse.</td>
</tr>
<tr>
<td><img src="image" alt="Printer Card Icon" /></td>
<td>Printer Card</td>
<td>Super Serial Card connected to a printer</td>
<td>Used instead of Serial Cards to control all printers. Choose the printer and set options using the Macintosh desk accessory called the Chooser.</td>
</tr>
<tr>
<td><img src="image" alt="Serial Card Icon" /></td>
<td>Serial Card (Modem Port)</td>
<td>Super Serial Card</td>
<td>Used to control a modem or any other serial device (except a printer) connected to the modem port of the Macintosh.</td>
</tr>
<tr>
<td><img src="image" alt="Serial Card Icon" /></td>
<td>Serial Card (Printer Port)</td>
<td>Super Serial Card</td>
<td>Used to control a modem or any other serial device (except a printer) connected to the printer port of the Macintosh.</td>
</tr>
<tr>
<td><img src="image" alt="SmartPort Card Icon" /></td>
<td>SmartPort Card</td>
<td>UniDisk 3.5 Interface Card</td>
<td>Controls the scanning order of the disk drives attached to your Macintosh LC.</td>
</tr>
</tbody>
</table>

Apple, the Apple logo, and Macintosh are registered trademarks of Apple Computer, Inc. UniDisk is a trademark of Apple Computer, Inc.
Tuck end flap inside back cover when using manual.
The Apple Publishing System

This Apple® manual was written and edited on a desktop publishing system using Apple Macintosh® computers and Microsoft Word. Proof pages were created on Apple LaserWriter® printers and on the QMS ColorScript 100 color printer. Final pages were produced in QuarkXPress and output directly to separated film on a Dolev PS imagesetter. Line art was created with Adobe Illustrator. Screen shots were created and modified with system software, Exposure, and SuperPaint.

Display type is Apple's corporate font, a condensed version of Garamond. Text type is Adobe Garamond. Ornaments are ITC Zapf Dingbats® and custom symbols designed for Apple Computer. Some elements, such as computer voice, are set in Apple Courier, a fixed-width font.

PostScript®, the LaserWriter page-description language, was developed by Adobe Systems Incorporated.